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Software License Agreement

Below you will find set out the conditions of the agreement for the use of Euro-Systems
Software by you, the end-user (hereinafter also called the Licensee). This legal document
is a legally valid contract between you, the end-user, and Euro-Systems S.à
r.l. (hereinafter also called the Licensor). With the installation, the first use or by opening
the disk package, you are agreeing to become bound by the terms of this agreement.
Therefore, please read the following text carefully and in full. If you do not agree to the
terms of this agreement, do not use the software open the disk package, promptly return
the unopened disk package and the other items (including all written documentations, ring
binders, if applicable dongle / copy protection or any other boxes) of the purchased
product to the place where you purchased them.

SINGLE USER / MAIN LICENSE - SECOND USER LICENSE(S) - ADDITONAL LICENSE
- DEMO LICENSE - TEST LICENSE - SCHOOL LICENSE / MULTI USER - COMPANY
LICENSE - ENTERPRISE LICENSE

1. Scope of the License Agreement
The agreement applies to computer programs and files stored on data carriers, computer
programs and files made available online, by data transfer or by installation on the
computer of the Licensee, the program description and operating instructions and any
other related written material and hardware, hereinafter also called Software. The Licensor
is entitled to implement program-internal protection measures into the software in order to
secure his protective rights. This also applies to future updates / upgrades of the program
provided to the Licensee. The Licensor points out that the present level of technology does
not allow computer software to be produced in such a way that it works perfectly in all
applications and combinations. Thus, the agreement is only applicable to software which is
basically usable in accordance with the program description and the user operating
instructions.

2. Granting of License

Important Note: If the copy protection (Dongle) gets lost, the license also expires!

Single User / Main License
The Licensor grants you the right to use the copy of the Software on only one terminal
connected to a single computer (i.e. with only one CPU). It is prohibited to network the
software beyond the scope of the software. You are not allowed to use the Software on
more than one computer or computer terminal in any way or at any time whatsoever
unless the Licensee additionally possesses so called Second-User Licenses or Additional
Licenses.

Second User License
A Second-User License as well is only valid in combination with a Single-User or Main
License. It is protected in the same way as the Single User / Main License. The functions
of a Second-User License are the same as those of a Main License. A maximum of two
additional Second User Licenses may be acquired for each Single User / Main License. If
more than three licenses are required in a multi user environment, it is first of all necessary
to acquire a further Single User / Main License. This license can then be used to acquire
two more Second User Licenses. Beyond - extra licenses are to be agreed individually and
in writing with the Licensor.
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Additional License
An Additional License authorizes the Licensee to use the copy of the software provided by
the Licensor on an additional computer. It is copy-protected in the same way as the Single
User / Main License. The functional scope of an Additional License is identical to that of a
Main License.

Demo License
The Demo License authorizes the Licensee to test the software in its scope of functions
(functionally partly limited), in particular to check whether the user value expected by the
Licensee can be achieved with the software and / or compatibility with its current computer
system. It is expressly forbidden to use the Software for commercial purposes, to transmit
it to third parties or to copy it without explicit written consent of the Licensor.

Test License
The Test License authorizes the Licensee to test the software in its scope of functions
(limited in time), in particular to check whether the user value expected by the Licensee
can be achieved with the software and / or compatibility with its current computer system.
The commercial use is expressly prohibited, as well as the distribution or duplication
without the explicit, written permission of the Licensor. The trial period starts with the
generation of the Test License.

School License / Multi User License
A School License consists out of a Main License for one teacher workplace and a so
called Multi User license for student's workplaces. The Multi User license is a functionally
restricted version of the software. Usage is allowed on multiple workplaces / computers in
the offices of the Single User / Main Licensee.

Company License
The Company License authorizes the Licensee to use a copy of the software provided by
the Licensor on several computers and / or multiple output devices on a company site. The
number of licenses must be agreed individually and in writing with the Licensor. If a
company has several locations, the Company License must be purchased separately for
each location. The Licensee is not allowed to transfer the licenses of one location to
another. If a company has several locations, an Enterprise License must be obtained

Enterprise License
The Enterprise License authorizes the Licensee to use the copy of the software provided
by the Licensor on several computers and / or multiple output devices at multiple company
locations. The number of licenses must be agreed in writing with the Licensor.

3. Copyright
The Software is the property of the Licensor and is protected against copying by laws on
copyright, international agreements and other national regulations. If the Software does
not have a device to protect it from being copied you may either make one copy as backup
or for your records or copy it to a hard disk as long as the original copy is to be stored
exclusively as backup or for your records. You are not permitted to delete the reference to
copyright in the Software or the registration or serial code or dongle numbers. It is
expressly forbidden to copy the Software and the written material such as manuals either
in full or in part or to reproduce them in any way.

Software License Agreement
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4. Special Restrictions
As Licensee you are not permitted

* to transfer, assign, rent, lease or otherwise dispose of the Software or related material to
a third party without the prior written consent of the Licensor. But you are allowed to
permanently assign the rights from this License Agreement to another person, provided
that you transfer the License Agreement together with all copies of the Software and the
accompanying hardware and the recipient consents to be bound by the terms of the
agreement. The transfer must include the latest update and all earlier versions and the
Licensor must be notified in writing.

* to modify, translate, reverse engineer decompile or disassemble the Software without the
prior written consent of the Licensor.

* to create derivative works based on the Software or reproduce the written material.

* to translate or modify the written material or produce derivative material.

5. Ownership of Rights
With the purchase of the product you only possess the physical data carrier on which the
Software is recorded or fixed. A purchase of rights of the Software is not connected with
it. In particular, the Licensor reserves all rights to publish, copy, edit and exploit the
Software.

6. Duration of the Contract
This License is effective indefinitely. This license will terminate automatically without notice
from EUROSYSTEMS if you fail to comply with any provision of the License. Upon
termination you are obliged to destroy the original data carriers as well as all copies of the
Software, modified copies including the written materials. You must return the hardware
and dongle to the manufacturer.

7. Damages for Non-Compliance with the Agreement
The Licensor points out that you are liable for any damage resulting from breach of
copyright incurred by the Licensor on account of your non-compliance with the terms of
this agreement.

8. Modifications and Updates
The Licensor may create updated versions of the Software at its own discretion. The
Licensor is not bound to make such updates available to Licensees who have not properly
registered the Software by registration card or online form or have not paid the update fee.

9. Limited Warranty and Disclaimer of Warranty
*1: The Licensor guarantees to the initial Licensee that, at the time of acquisition, the data
carrier on which the Software is recorded and the hardware shipped with the software is
error-free under normal operating conditions.

*2. Should the data medium or the hardware delivered with it be faulty, the purchaser can
demand a replacement during the warranty period of six months after delivery. He must
return any hardware supplied including the backup copy and the written material and a
copy of the invoice/receipt to the Licensor or the dealer from whom the product was
purchased.

Software License Agreement
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*3. If a replacement for a faulty item, as mentioned in 9.2, is not provided within a
reasonable period of time, the purchaser can demand either a reduction of the purchasing
price or rescission from the contract.

*4. For the reason mentioned in 1., the Licensor does not guarantee the faultlessness
of the Software. In particular, the Licensor does not guarantee that the Software meets the
Licensee's requirements and purposes or works in connection with other programs
selected by him. The Licensee bears all responsibility for the correct choice and the
consequences of using the Software and for the results intended or actually achieved. The
same applies to the written material accompanying the Software. If the Software is not
usable in accordance with 1., the Licensee has the right to rescind the contract. The
Licensor has the same right when it is not possible to manufacture usable
Software with reasonable effort in accordance with 1.

*5. The Licensor is not liable for damage unless the damage was caused deliberately or
through gross negligence on the part of the Licensor. Any liability for gross negligence
towards dealers is excluded. Liability due to properties maybe warranted by the
Licensor remains unaffected. Liability for consequential harms caused by a defect that is
not included in the warranty is excluded.

10. Traders
If the Licensee is a trader, this agreement shall be subject to the law of Luxembourg and
the jurisdiction of national and federal courts located in Luxembourg.

11. Data Transmission
* 1: The Licensee authorizes the Licensor to store and process his customer data
communicated in connection with the business relationship.

* 2: The Licensee agrees to the transfer of software data to the Licensor for the protection
of legitimate interests, such as to ensure copy protection, license verification and the
provision of Live Update functionality.

* 3: The Licensee agrees that any data sent by the Software online to the Licensor for the
provision of online services (online support, driver download, license purchase, provision
of production macros, and the like) shall be stored and processed from the Licensor.

* 4: The Licensee agrees that data that serves the needs-based development of the
Software are transmitted to the Licensor and stored and processed by him.

* 5: The Licensee agrees that data will be sent to the Software to inform the Licensee
about updates / upgrades, product news and important support information.

LIMITED WARRANTY

* Limited Warranty - The Licensor guarantees that the Software functions largely in
accordance with the accompanying product manual for a period of 90 days from receipt.

This guarantee is given by the Licensor in its capacity as producer; it does not replace or
restrict any possible legal claims regarding warranty or liability which may be made on the
distributor from whom you purchased your copy of the Software.

Software License Agreement
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* Customer's Rights - The Licensor's entire liability and your sole right consists in a refund
of the price paid or the repair or replacement of the Software which is inadequate under
the terms of the Licensor's' limited warranty and which has been returned to the
Licensor together with a copy of the invoice. This limited warranty does not apply when the
non-functioning of the Software or hardware is due to an accident, improper use or
incorrect application.

* No Further Guarantee - The Licensor excludes any further warranty for the Software,
accompanying manuals and written materials or the accompanying hardware.

* No Liability for Consequential Damage - Neither the Licensor nor the distributors of the
Licensor are liable for any damages (unlimited included are damages for loss of business
profits, business interruption, loss of
business information or data or from other financial loss) arising out of the use or inability
to use such product even if the Licensor has been advised of the possibility of such
damage. The Licensor is not liable for damages, as far as the Licensee could have
prevented their occurrence by means of reasonable measures - in particular program and
data backup. In any case the Licensor's liability is confined to the amount actually paid for
the product. This disclaimer does not apply to damage caused deliberately or by gross
negligence on the part of the Licensor. Neither does it affect any rights based on legal
regulations concerning product liability.

* When outputting data to connected devices (locally connected to the computer or in a
network (LAN / WAN) the safety instructions of the machine manufacturer must be strictly
observed in any case.

If you have questions about this contract, please contact the Licensor: Euro-Systems S.à
r.l, Villa Machera, 1 Rue Kummert, L-6743 Grevenmacher, Luxembourg
© Euro-Systems 2020

Software License Agreement
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Important Information for CoCut Clients

Please check the merchandise after the reception upon completeness and announce
possible absence of single parts immediately to your trader.

The scope of delivery of a CoCut version includes:

- Program CD (apart from download version)
- Manual on CD or as PDF file

Code number

The sticker is on the inner side of the manual cover. In case of online buy code number is
delivered via email.

System requirements

Pentium 4 or newer with min. 1 GB RAM•   
Windows 7 / 8 / 10 (32 or 64 bit)•   
Minimum graphic resolution: 1024 x 768 pixels•   
Host program: Inkscape•   

Restriction of Warranty

We have given the greatest effort with the illustrations and while writing the texts.
Nevertheless, mistakes for this manual and the corresponding programs can not be
entirely excluded. No guarantee is taken for the correctness of the content of this manual,
its translation, its completeness and exactness.

We expel the liability for all losses which appear by the use of the CoCut or its
documentation. The content of this manual can be changed without announcement and is
not to be considered as an obligation of EUROSYSTEMS S.à r.l.

The authors cannot take over any responsibility or liability for incorrect information and
their consequences.

Trademark

Possibly found trademarks are used without their usability can be guaranteed.

The following programs were applied among other things: CorelDRAW, Postscript,
Microsoft, Windows, Illustrator, InDesign, Freehand and AutoCAD. These trademarks are
owned by the respective producer.
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Support And Sales Information

Dear user,

in order to guarantee the direct communication with your competent contact person in
case of problems and questions and in order to avoid or shorten waiting times on the
phone we offer the service of the technical hotline.

This service is available from:

Monday - Friday from 9:00 a.m. until 12:00 noon MET

Phone: ++49 6502-9288-11

Further helpful information as well as tips and tricks are on our website:

www.eurosystems.lu

under the category Support / FAQ

Our support staff members only give information to registered users. Therefore, please
give following information upon each call:

- Version-No.: e.g.  CoCut Professional 17.002
- Dongle or serial number of respective product

Thank you for your understanding that inqueries by phone can only be handled by using
this phone number. Other direct dialling numbers that may be known to you are reserved
for purchase and sales department.

In order to guarantee a smooth and competent support for yourself and others, we kindly
ask you to get registered. Immediately after the reception of your registration card, your
registration per fax or online, you will be added to our user-database.

RCS Systemsteuerungen GmbH
Generaldistributor für EUROSYSTEMS-Produkte.

PS.: For written inquiries or the fast registration per fax or online, please use the following
number or address:

Fax:  ++49 6502-9288-15

Web Site: www.eurosystems.lu

Imprint

Comment to the production:

This manual was created with our own document system. Modifications and errors
reserved.

Support And Sales Information
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Used font family: Arial

English version:
Heidi Hansen, Peter Bettendorf
RCS Systemsteuerungen GmbH

Date: 06/27/20

Imprint
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Copyright

Copyright © 2020 by Euro-Systems S.à.r.l. - All rights reserved.

Any duplication of this manual as well as the computer software CoCut for Windows will be
prosecuted.

The rights for the documentation to CoCut lie with
Euro-Systems S.à r.l., Villa Machera, 1 Rue Kummert, L-6743 Grevenmacher,
Luxembourg

Typeset and composition: Peter Bettendorf
Text: Peter Bettendorf, Frank Thömmes

The legitimate acquisition via data carrier or download allows the use of the program,
analogously to the use of a book. According to the impossibility that a book is read at the
same time in different places by several persons the software program CoCut may not be
used at the same time from different persons in different places and on different devices.
Copies may be created only for the purpose of data backup.

CoCut uses the OpenCV

(Open Source Computer Vision Library)

IMPORTANT: READ BEFORE DOWNLOADING, COPYING, INSTALLING OR USING.

By downloading, copying, installing or using the software you agree to this license. If you
do not agree to this license, do not download, install, copy or use the software.

Intel License Agreement

For Open Source Computer Vision Library

Copyright (C) 2000, 2001, Intel Corporation, all rights reserved.

Third party copyrights are property of their respective owners.  Redistribution and use in
source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

* The name of Intel Corporation may not be used to endorse or promote products derived
from this software without specific prior written permission.
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This software is provided by the copyright holders and contributors 'as is' and any express
or implied warranties, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose are disclaimed.

In no event shall the Intel Corporation or contributors be liable for any direct, indirect,
incidental, special, exemplary, or consequential damages (including, but not limited to,
procurement of substitute goods or services; loss of use, data, or profits; or business
interruption) however caused and on any theory of liability, whether in contract, strict
liability, or tort (including negligence or otherwise) arising in any way out of the use of this
software, even if advised of the possibility of such damage.

CoCut uses NLog

NLog is a free logging platform for .NET, Silverlight and Windows Phone with rich log
routing and management capabilities. It makes it easy to produce and manage high-quality
logs for your application regardless of its size or complexity.

Copyright (c) 2004-2011 Jaroslaw Kowalski

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

* Neither the name of Jaroslaw Kowalski nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

CoCut uses the OpenCV
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About This Manual

With this manual you receive CoCut. This manual is divided in 8 chapters.

In chapter „Quickstart and installation“ the installation of CoCut on your Windows
computer will be explained. Please follow the installation instruction carefully as the correct
installation is the basic for the smooth usage of CoCut.

The chapter „How to work with CoCut?“ is an introduction in handling, tools and
functions. The functional principle will be concretized by means of practical examples.

In chapter „Reference part“ all menus and their menu items in their chronological order
are explained. This chapter is thought of as reference book and should be used in case of
doubts about the exact functioning of a command.

In chapter „Reference part display preview” all menus and their menu items in the
display preview in their chronological order are explained. As chapter "Reference Part" it is
thought of as reference book and should be used in case of doubts about the exact
functioning of a command.

In the next chapter all „Tools” are described.

In chapter „Tips and Tricks / Trouble Shooting“ we have explained a selection of daily
problems from our hotline and support experience and give you information for dealing
with technical problems.
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Typographical Orientation Guides

Display Meaning

Bold Headlines

Italic Indications, accentuations

Bold, italic Menus, fields, options e.g. new-command

CAPITAL
LETTERS

Name of keys on the keyboard e.g. INS, SRTG, …

KEY1+KEY2 The plus (+) between the key names means that the first key must be
kept pressed while pressing the second key. Afterwards, let go the two
keys.

KEY1,KEY2 A comma (,) between the key names means that you press the keys one
after the other and let them go.
Shortcuts and hotkeys

… Three dots after menu entries and commands always mean that, when
activating, a dialog window will be opened.

Typographical Orientation Guides
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1 Quickstart and Installation

1.1 Quickstart

1.1.1 How to Install CoCut?

1.1.1.1 Step 1: Connection

Cutter control via USB

Install cutter USB drivers, which were delivered by the cutter manufacturer. Please use the
instructions given by cutter manual.

Cutter control via COM port (serial)

Make sure, that cutter and serial Windows port are configured identically.

You´ll find this port configuration in the system Control Panel under:
System/Hardware/Device Manager/Ports/Communications Port. Select via double click the
respective port (e. g. COM1) and activate Port Settings.

Default settings are: Bits per second: 9600 or 19200, Data bits: 8, Parity: None, Stop bits:
1, Flow control: Hardware

Check also Resources: COM 1: I/O Range 03F8 and IRQ 4 and COM 2:
I/O Range 02F8 and IRQ 3 respectively

1.1.1.2 Step 2: Installation

Insert the CoCut installation CD. With the Autorun function switched on following dialog
opens. If the Autorun function is deactivated open the Windows Explorer and start the file
install.exe in the main directory of the CD. Select product CoCut Starter 2017 and start
installation.
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Fig. 1.1-1: Autorun window

Note: Installation process is done again for each selected application.

Fig. 1.1-2: EUROSYSTEMS Software License Agreement

In this dialog the installation folder for CoCut Starter 2017 is chosen. By default the folder
C:\Program Files\EUROSYSTEMS\CoCut Starter 2017 is suggested.

1.1.1 How to Install CoCut?
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If CoCut should be installed to another folder, please click Browse button and select the
desired destination folder.

Fig. 1.1-3: Selection of destination folder

Hint: To install additional drivers select custom setup.

1.1.1 How to Install CoCut?
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Fig. 1.1-4: Selection of setup type

Default program folder in the start menu is EUROSYSTEMS\CoCut Starter 2017.

1.1.1 How to Install CoCut?
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Fig. 1.1-5: Position in start menu

1.1.2 Enter License Data (without Dongle)

1.1.2.1 Use .ecfn file: Recommended, if license data was sent via
email.

In the eMail with license data you´ll find an attached file with the extension .ecfn.

A double click on this file will license your software automatically!

1.1.2.2 Manually, if license data is printed on a sticker, which is
located in the package (inner left hand side).

On this sticker you´ll find information about program version, serial number, user data and
the code itself.

Important! All license data must be entered exactly how printed!

1.1.2 Enter License Data (without Dongle)
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Fig. 1.1-6: Start window with invalid code

By clicking "License..." button following dialog is opened.

Fig. 1.1-7: Option for first installation of CoCut Starter 2017

1.1.2 Enter License Data (without Dongle)
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Fig. 1.1-8: These fields have to be filled with license data

1.1.3 Enter License Data (with Dongle)

If copy protection is realized using a dongle (frequently in case of upgrades),
don´t forget to connect the dongle with a port on your PC.

1.1.3.1 Manually, if license data is printed on a sticker, which is
located in the package (inner left hand side).

On this sticker you´ll find information about program version, serial number and the code
itself.

Important! All license data must be entered exactly how printed!

1.2 Autoexport - Scripts

Autoexport means that data from external programs (CorelDRAW, CorelDesigner,
Illustrator, Freehand, Inkscape, InDesign) are imported automatically into CoCut - quasi at
the push of a button. To do this the scripts are either integrated into the external program's
menu structure or toolbar.

1.1.3 Enter License Data (with Dongle)
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1.2.1 Corun Installer

With the Corun Installer you can install CoCut the plugins. In the Name column all host
programs are listed, in which the plug-ins can be implemented. In the Plugin path column
is displayed in which the folder the plug-in files are located after installation. In the
Eurosystem software list all programs are listed that have a plug-in functionality. Select the
appropriate program from the list. Activating the Install button starts the process.

Note: The Corun Installer is required if the host application was installed BEFORE
the EUROSYSTEMS program or if plugins must be re-installed.

Fig. 1.2-1: Corun Installer dialog window with detected host programs and path indicators.

1.2.1 Corun Installer
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1.2.2 CoCut Script in Inkscape

The CoCut - script for Inkscape is located in the Extensions menu. The output routine is
activated using the cutting menu entry in the CoCut Starter 2017 sub menu.

Important note: The plugin only works with the non-portable version of Inkscape.

1.3 Selection of The Device Driver

Please, select first your output device from the list driver. In the field name of device  the
identical name for the selected device that is shown in the cutting dialog appears. This
name can be changed individually in this field. After the selection of the driver please
select - in the area type of connection - the device type with which the device is
connected to the computer.

Tip: If the driver you search for is not in the list you can try another driver from the
same manufacturer.

Fig. 1.3-1: Dialog for the selection of the device driver

Detailed information for the setting of the local interface is here: please refer to 2.5:
Cutting - Milling - Creasing - Drawing …

1.2.2 CoCut Script in Inkscape
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1.3 Selection of The Device Driver
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2 How to work with CoCut

2.1 Desktop and Working Sheet

2.1.1 I. Desktop

The so-called Desktop means the whole visible program window including Toolbars,
Working Sheet and Desktop background.

Note: On the background can be placed any desired number of objects. The size of
the background is limited only by the resources of your computer. Thus the layout
can be done basically in 1:1 scale.

Fig. 2.1-1: Desktop with working sheet (here: gray), Background (here: white), Toolbars,
Sidebar, Rulers, Statusbar

2.1.2 II. Working Area

The workspace is a subset of the CoCut desktop. The workspace is usually in the format
that will later be output on a machine. In addition to the known DIN formats, any formats
can be applied, e.g. for different table sizes.
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Note: The working area is used primarily for guidance. The format of the working
area has no influence on the output on a connected device. The output preview
window displays what is given out.

please refer to 2.5: Cutting - Milling - Creasing - Drawing …

Fig. 2.1-2: The Working Area Dialog

2.1.2.1 The Buttons

The New Button

The New button creates a new format. The values for width and height of the selected line
are transferred to the new row.

The Delete Button

The Delete button removes the marked row.

The Change Button

This button saves all changed parameters and options.

The Default* Button

This button marks the name with a * (star). The star-marked format is used every time
CoCut is started.

2.1.2 II. Working Area
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The Read from connected device Button

By means of this button - if the read-out command of the driver is processed by the
machine controller - the width value can be read from the connected device and inserted
into the width field.

The Change orientation Button

This button changes the orientation of the working space from portrait to landscape and
vice versa.

The OK Button

The OK button accepts the changed values and closes the dialog.

The Cancel Button

This button closes the dialog without saving any changes.

2.1.2.2 The Areas

The Preview Area

In this area, the worksheet, the desktop background, their colors, as well as the orientation
are displayed proportionally reduced.

The Format Area

Name

The name of the format is entered in this field and the name of the selected one is
displayed.

Width

In this field, the width of the format is determined.

Height

In this field, the height of the format is set.

The Margins Area

Left, Right, Top, Unten

These 4 fields define the distance of the borders from the edge of the working area.

Note: Negative values are also allowed.

2.1.2 II. Working Area
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The Color Area

Foreground

Here, the color of the worksheet can be defined as RGB value.

Background

Here the color of the background desktop can be defined as RGB value.

2.1.2.3 The Options

The Fit to objects Option

This option captures the objects outside the working sheet and extends the sheet by the
amount necessary to accommodate all the objects on the working sheet.

The Show margins Option

This option displays the defined borders as dashed lines in front of the working sheet.

The Select image Option

This option displays the selected bitmap in the preview and later on the working sheet.
The ... button opens the file dialog for selecting the desired bitmap.

The Scale Objects too Option

If the height or width of the working sheet is changed, all objects on the working sheet are
reduced or enlarged by the same amount.

The Rotate Objects too Option

This option determines whether the objects on the working sheet and on the desktop
background will also be rotated when the orientation is changed.

The Accept working area dynamically from current device Option

This option ensures that the width and height values of the working area are read from the
connected device and used. For each device, a format is created with the name of the
device in the list.

2.2 Job Preparation

2.1.2 II. Working Area
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2.2.1 Import

With this command the graphics that have not been saved in the CoCut-job-format are
transfered to the working surface.

The functionality of this dialog box corresponds to the open file command. Differences are
only due to the possibility to change the size of the data to be imported by means of the
parameter X- and Y-factor. The desired file is chosen respectively specified via the name
of file, type of file and directories (search in).

Fig. 2.2-1: Import window with preview

With the preview window in the import dialog all following formats can be displayed.

*.ai/eps, *.pcx, *.jtp, *.tif, *.bmp, *.wmf, *.emf, *.dxf, *.gif, *.hpgl, *.gtp, *.ik, *.svg

Indication: With text files (*.txt) the preview window is switched off.

2.2.1.1 Import Presettings

For many import operations, constraints can be defined to be taken into account before,
during or after importing the data. Constraints can effect the DXF or HPGL import or all
import operations.
Also for export constraints are definable in this window. Thus, a special option on job files
can be activated, for example, the PDF export. The constraints are extensively recorded

2.2.1 Import
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in the following article. please refer to 3.5.1.4: The Import Setup

2.2.1.2 PDF Import

2.2.1.2.1 Additional Options

Fig. 2.2-2: Options concerning import of data

Integrated Job File

The Extract Button

Enabling the Extract ... button ensures, that the import function loads the integrated job
file on the desktop, while extracting the PDF file.

Note:  A prerequisite for this is that when you export the appropriate option in the
preferences (see above) was made.

Raster Options

Import as Bitmap Option

2.2.1 Import
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If the Import as Bitmap option is enabled, then all vectors will be rastered into a bitmap
before the import.

Resolution

The value in dpi

Element Selection

Ignore Images Option

If the Ignore Images option is enabled, then no images will be imported.

Ignore Text Option

If the Ignore Text option is enabled, then no texts will be imported.

Page Selection

In the input field the page number can be entered, which should be imported.

All Pages Option

If the All Pages option is enabled, then all pages of the document will be imported.

Search in

In the row Search in the path can be set that shall be searched.

File name

If the file name is know it can be entered into this field

Type of file

Here, you have to choose the format of the file to be imported in order to activate the
corresponding import filter

Preview

The activation of this option draws a preview of the file content to the left preview window

Insert at Position (0,0)

This option inserts the objects at the 0 (zero) position of the CoCut-working surface.

X Factor, Y Factor

With these two factors the data can be scaled (increased or decreased) during the import.
The scale can be proportional or unproportional.

2.2.1 Import
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2.3 The CoCut Layer dialog

In the layer-settings dialog the parameters necessary for the output are set and attributed
to an object, a color respective a layer. The dialog opens by a right mouse click on the
CoCut layer-toolbar in the main window.

Fig. 2.3-1: Layer setup with adjustment of output parameters

In the Information field a name for the layer can be entered. This name is shown later in
all dialogs in which the colors of the objects are needed. 

In the Mode / Tool field the output tool can be selected from a list. The tools shown here
depend on the used output driver.

In the Material field already saved material-configuration can be called up. The
material-configuration can be created, saved or deleted with the button right of the
selection box.

Indication: By clicking with the left mouse button on another color the settings are
saved and the values of another layer can be edited.

2.3 The CoCut Layer dialog
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2.4 The Output

2.4.1 Device Setting - Interface Setup (Local Device)

The CoCut output

With this command you activate the module for cutting, milling, creasing and drawing of
your data.

You activate this function via the  button in the tools toolbar or via the file
menu, menu entry output…

S

Fig. 2.4-1: The output button

When first opening another dialog will be opened before in which the driver of the device
as well as the connection has to be defined.

Fig. 2.4-2: Driver and selection of the connection 

General

Under the part of the dialog named General you select the driver of the device.

In the right list all device drivers are listed that are available in CoCut. In the left list an
individual name for the driver can be distributed. This name will be used in the output
dialogs of CoCut.

2.4 The Output
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Enable as server

Requirements are at least 2 licenses of CoCut.

If the option enable as server is activated the output device will be marked as plot server
and can be used by another Plot Manager for the output.

The characteristic features of an output device are that a driver for the processing of the
data has to be distributed to this output device. On the computer on which the Plot
Manager is running the job data for the output are transformed into device data by means
of a driver. The output of the device data can be done in several ways:

Types of connection

Local interfaces

Local interfaces are the interfaces (COM1, COM2, ..., LPT1, LPT2, ...) that are directly on
your computer.

The activation of the settings button opens a dialog for the configuration of the
interface. These settings that are done here apply for the whole system.

Fig. 2.4-3: Dialog for the setting of the interface parameters

Indication: When steering serially you have to pay attention that all settings on the
side of the computer as well as on the side of the output device correspond.
Otherwise there is no or faulty communication between them.

2.4.1 Device Setting - Interface Setup (Local Device)
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USB / Firewire Devices

Here, all momentarily connected USB / Firewire devices are listed.

TCP / IP

Here, you have to enter the TCP / IP address and the port number to which shall be
output.

Spooler

Here, you can select a Windows printer driver.

When opening the output dialog again it will be opened directly with the previously set
device driver.

2.4.2 Device Setting (Network Device)

When selecting the menu item create network device … following dialog will be opened:

Fig. 2.4-4: Dialog for the configuration of a plot server

A network device enables the output of CoCut jobs on a Plot Manager that runs on
another computer. Contrary to a "normal device" the data are not locally transformed into
device data but transferred unchanged to the plot server for the further processing.  

2.4.2 Device Setting (Network Device)
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Device name

In the entry line enter the name of the device.

Server selection

In the area named server selection enter the TCP/IP address if you use a TCP / IP
connection or the name of the computer that is used.

Network

If a connection shall be done via a network the configuration file of the plot server,
the plotman.ini, must be selected.

Devices (of server)

If the actualize button is pressed the devices of the server are read.

Indication: The device of the server can only be read if the server was selected as
only then, the devices of the server are available.

Driver

In the field driver the device driver is entered that the server uses for this device.

Indication: This driver must also be created locally, which means as local device. 

2.4.3 Start Output from the CoCut Working Surface

The output is started using the plotter icon .

Fig. 2.4-5: Pre-processing line weight and color gradient

If a CoCut job contains objects with the attributes pen thickness and/or color graduation
a preceding dialog appears. The object attributes can be transformed into vectors so that
they are taken into consideration at the output. After clicking on the OK button the object
attributes are transformed into curves.

2.4.3 Start Output from the CoCut Working Surface
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2.4.3.1 Output to Device

Fig. 2.4-6: Output dialog

Output

In the area named output of the output to device dialog you can control most of
the parameters that are directly or indirectly in contact with the output device.

Device

In the device field the previously defined output device is shown.

Mode

In the mode field  the required output mode is preset.

2.4.3 Start Output from the CoCut Working Surface
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Output Profile

In the field output profile the required profile with individual settings and values is
selected.

Manage Profiles Button

Clicking on the  button opens the following popup menu:

Add

Activating the Add menu item writes a new data record into the profile database.

Save Profile

Selecting the menu item Save profile the prior to this edited and changed values are
written into the profile database.

Profile Defaults

Activating the menu item Profile defaults resets all Values to the default value. The
profile values are reread.

Mode / Tool Defaults

Activating the menu item Mode / Tool defaults resets all Parameters to the internal
driver values.

2.4.3 Start Output from the CoCut Working Surface
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Number of Jobs

The value in the field number of jobs repeats the last output without the reading of the
video marks with identical output parameters such as scaling, etc. Only layers with tools
are given out. This variant protects against the fact that layers are output with no tool
assignment. This means that there is no error output due to the use of the last active tool.

Copies per Job

In the field copies per job you define how often the selected objects shall be cut. After the
cutting this value is automatically reset to 1.

Copy Spacing Y-Direction

The value in the field Copy spacing y-direction defines if the copies shall be stacked
vertically and which space has to be kept between the copies. Pre-condition for the
activation of this option is that the selected object can be cut more than one time on top of
each other!

Indication: In the preview the first object is shown „normally“. Each further object of
the stack is shown dashed in blue.

Copy Spacing X-Direction

The value in the field Copy spacing x-direction defines the space between the copies
that were entered in the field Copies per job.

Weed Border Distance

With the option Weed border distance it is defined if and with which space a rectangle is
cut around the plot that facilitates the weeding of the foil. In the output preview the frame
- if activated - is shown dashed in blue.

Segment Spacing

The segment spacing defines the horizontal space between the single segments.
Segments always occur if the job has to be sectioned which means divided.

Only Output Tool-Assigned Layers

By activating this option, only objects from a layer with an assigned tool are transferred to
the Plot-Manager.

Send Design Relative to Origin

Via this option the zero point (0/0) of the cutter can be moved. If this option is not
active CoCut selects automatically the physical zero point as starting point for the cutting.

2.4.3 Start Output from the CoCut Working Surface
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If the Send design relative to origin option is active the physical zero point is
moved relatively to the offset coordinate of the reference point. The coordinates of the
reference point corresponds to the position of the down left corner of the object to be cut
on the CoCut working surface.

Plot to File

If the option plot to file is active all output data are directed to a file you have named and
written onto the hard drive.

Enable Tool Tips

If this option is enabled, explanatory texts regarding parameters, values or options are
displayed, if the mouse cursor is located directly above.

Pause after Feeding a Segment

Sectioning / Segmentation: If a job is too big for the output CoCut separates the
job automatically in so many parts (segments) that are necessary for the complete output
of the job.

If the option Pause after feeding a segment is active the output is interrupted after each
segment and the material can be re-adjusted if necessary.

Save Settings Button

By activating the Save settings button all values that have previously been entered in the
output dialog are stored and assigned to the currently active output device.

2.4.3.2 Sort Options

Sort before Output

If the option Sort before output is activated all objects in the working surface are sorted
1. in head direction and 2. in transport direction.

Actual Setting

Fig. 2.4-7: Main direction icon

The icon shows which main direction is selected in the output to device dialog.

Always Prefer Job Order

This option ensures, that the sorting that was made before, is not changed through an
alternative sortation.

2.4.3 Start Output from the CoCut Working Surface
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The Button

The sort options button opens the output settings dialog.

Accuracy

The Accuracy field offers the following settings: very low, low, normal, high and very
high. As default, the value normal is set.

The accuracy defines of how many vector parts an object should consist. This is only
relevant with objects whose size range in ten thousands of a millimeter. Other object sizes
are calculated automatically by CoCut.

Feed / Origin

Depending on the selected driver the field name is either feed or origin.

Friction Feed Cutter

With origin the options are new origin or don't set. If the option new origin is selected
the device goes into X-direction at a fix set value behind the last cut object and this
position is then the new origin. If don't set is activated the physical zero point is the new
origin after the output.

Flatbed Cutter

With feed the options are feed or no feed. If the option feed is activated the material feed
is carried out with the sectioning and with the output from the roll if the flatbed cutter has
an automatic material feed.

Objects

The field Objects allows the selection of the objects to be output. Besides the modes all
objects and selected objects CoCut also allows the cutting of color sequences or of
single color layers. The two last named are explained more in detail in the chapter „color
separation when cutting".

Fig. 2.4-8: List field objects with selection modes.

2.4.3.3 Parameter / Value Table

The table Parameter / Value allows the access to the parameters of device and
driver. The area is divided in parameter and value. The width of the display can be
changed by moving the vertical line between the areas with the mouse. Whenever Edit…

2.4.3 Start Output from the CoCut Working Surface
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is displayed in the value column a double-click opens the corresponding window for the
setup of a group of parameters.

Fig. 2.4-9: Example for an opened parameter group

Info Line

In the Info Line information relating to the output process is displayed additionally, e. g.
"Job will be sectioned".

Test Drive

If the test drive button is activated the connected device drives along the weeding frame
with the tool head lifted. This also happens if the option weeding frame is not active.

Preview or Direct Output

The Preview button opens the output preview. Direct output suppresses the preview
window. After pressing the output button, the plotter commands are transferred to the
plotter together with the data.

Output

The Output button transfers the data directly to the Plot Manager and to the connected
device.

Read Material Size

The Read material size button delivers back to all connected devices the height of the
area to be plotted if an accordant command is intended in the firmware for the device.
Devices that do not offer this option no value respective zero is delivered back.

2.4.3 Start Output from the CoCut Working Surface
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2.4.3.4 Color Separation when Cutting

Each layer color used in the draft appears again in the objects list with the number that
clearly defines each layer color. In addition, in this list field two horizontal color bars
appear. After having transferred the data of a color layer, in the info area of the Windows
status bar the Plot Manager icon ( ) appears.

Double clicking on this icon activates the Plot Manager job control. If the mouse cursor is
positioned on the icon and the right mouse button is pressed, a pop up menu appears in
which the Plot Manager can be closed or the program version can be shown. In the layer
selection the color layers that have not been processed yet occur in the order in which
they had been selected. The order in the stack can be changed at any time.

Fig. 2.4-10: Definition of the order in which the single layers shall be processed by up /
down buttons

The order is defined via the up / down buttons. Layer colors that are not necessary are

deleted from the list with the  button.

Tip: For the color separated cutting use the register marks from the draw
tool. Register marks are cut at the same place on the foil independently from the
used color.

2.4.3 Start Output from the CoCut Working Surface
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2.5 Cutting - Milling - Creasing - Drawing …

2.5.1 The Output Preview 

The output preview is automatically started if you press the preview button in the output
dialog. 

Closing the output preview and returning to the working surface of CoCut ESC

Fig. 2.5-1: Output preview with toolbars, status line and output objects

In the status line of the cutting preview the following information is shown: contour, filling,
width and height, group or combination, the max. foil consumption in square meters
and running meter (rnm) as well as selected object features. If the output menu is
activated the data are transferred to the output device.

Indication: If the job to be cut is left, underneath or above the material- or table
preview and the output -menu is activated you will automatically be reminded that
the objects to be cut are out of range of the output.

Detailed description:
please refer to 5.7: The Preview Tools Toolbar
please refer to 5.8: The Preview Object Parameters Toolbar

2.5 Cutting - Milling - Creasing - Drawing …
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2.5.1.1 Foil optimization 

The material consumption can be reduced by using the module foil optimization.

Fig. 2.5-2: Parameter dialog for the material optimization

The foil optimization takes care that all objects are arranged in a way that they take the
least space on the material.

Indication: Groups and combinations are each regarded as an optimization object. If
this is not desired the grouping must be interrupted and the combination cancelled.

Following options are available:

Weed border distance

In this field the desired distance between the optimization objects, the so called weed
border distance can be set.

Rotate objects to shorter side

All objects are rotated so that the shorter side is downwards.

Rotate as needed

During the optimization all objects are rotated so that they can be arranged saving the
most space.

Include bitmaps

If this option is activated, bitmaps and groups that contain bitmaps are also optimized.

2.5.1 The Output Preview 
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Only selected objects

Only the selected objects are considered. With this option you can for example optimize
according to layers (colors).

Maximum optimization

If this option is activated two more fields are shown in the foil optimization dialog. The
option maximum optimization calculates all possible combinations the can arise from the
fields end optimization up to maximum ... objects and permutation depth. The
calculation can take much time depending on the size of the here set values as all
possible combinations that arise from the two values are calculated and compared.
Therefore, you should usually not set more than 20-30 objects with a permutation depth of
max. 5.

Indication: An optimization always leads to the rotation of one or several objects.

2.5.1.2 Weeding lines 

Weeding lines serve for the better procession of large jobs. Material length or width of
several meters are difficult to handle, therefore, you can insert weeding lines during the foil
cutting that divide the job into smaller parts that are more easy to handle.

Fig. 2.5-3: Output job with weeding frame (dashed in blue) without weeding lines

2.5.1 The Output Preview 
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Fig. 2.5-4: Example with 3 horizontal and 3 vertical weeding lines (dashed in red)

Fig. 2.5-5: Result of the output with weeding lines - objects not! cut

In the output preview there are 3 possibilities to insert horizontal and vertical weeding
lines.

Indication: Weeding lines can only be inserted if the option weeding frame has been
activated in the output dialog.

1. Manually

Position the mouse cursor on the weeding frame dashed in blue around the objects. The
mouse cursor changes into a double-headed arrow. Now draw a horizontal or vertical

2.5.1 The Output Preview 
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weeding line to the position where it should be segmented. Repeat the process until all
necessary weeding lines are inserted.

2. Via the menu options

Open the menu options and activate the menu item horizontal weeding line or vertical
weeding line.

The first weeding line is inserted in the middle of the objects to be cut. The second call up
of the function bisects the two halves in two more halves and so on.

3. Via the shortcuts h or v

An „h” or „v” directly entered via the keyboard generates the respective weeding lines - as
described in 2.

Tip: Single objects can be provided additionally with a separate weeding frame via
the right mouse menu.

2.5.1.3 Job Sectioning

Sectioning is the division of a job in so many parts (sections) that are necessary for the
complete output of the job.

If the job to be output is bigger than the set or the available output width (output dialog,
field width of material) of the output device in the information area of the output dialog
the indication „job will be sectioned“ is shown.

Indication: The terms sectioning and segmentation are used as synonyms.

The activation of the output menu then opens the following dialog before the transfer to
the device:

Fig. 2.5-6: Sectioning dialog with overlapping of 3 mm

2.5.1 The Output Preview 

48



Optimize material (max. size + smallest at last)

Optimize … smallest at last) causes CoCut to create segments in the maximum
permitted size. The size of the last segment usually differs from the others

Optimize material (max. size + smallest at first)

Only active with flatbed cutters. If the last segment was also cut as last the plate could not
be processed until the end. Therefore, the remainder is cut as first so that the plate lies on
the table until the end.

Segment optimization (segments of equal size)

If the option segment optimization is activated always segments of the same size are
created.

Optimize segments by mark posiions

This option is activated as default with CoCut if video markers exist in the Job. The above
dialog is skipped and the preview of the dynamic segments is shown. The reason of this
optimization is that always at least 3 video markers are necessary. Depending on the
location of the video markers CoCut "searches" up to 30% next to the segment line if there
is a video marker. If yes, the respective segment is adjusted dynamically.  

Preset segmentation

The last used setting is automatically saved. When loading the job again this sectioning
can be accessed.

Reverse cutting

The option reverse cutting indicates that the objects are cut as „negative“ for example for
the use as template for the screen printing.

X-overlap and Y-overlap

Segmentation with overlapping - In the fields X- and Y-Overlap you can define how much
the segments shall overlap. The vectors are enlarged accordingly at the cutting points.

2.5.1 The Output Preview 
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Fig. 2.5-7: Foil optimization in the sectioning preview with 8 segments and information on
segment sizes

Selection and deselection of the segments

Selection and deselection of the segments is done by clicking into the segment. The red
checkmark indicates which segment is active and being output. 

Changing the suggested sectioning

You can change the sectioning by clicking on the blue section lines and move them to the
desired position with the mouse. If necessary CoCut inserts automatically new sections.

In the status line of the segmentation preview the size of the job to be cut in X- and
Y-direction and the number of segments are shown.

2.5.1 The Output Preview 
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3 Reference Part

The menu items in chronological order:

3.1 The File Menu

3.1.1 The New… Command

With the New command a new job is opened. CTRL+N

3.1.2 The Open… Command

With this command the files that were stored on your hard drive or another
data carrier in the CoCut JOB file format are brought onto the current screen
/ desktop. You can further edit this file. Jobs can be deleted after a safety
query.

 CTRL+L

3.1.3 The Save Command 

With this command you save the current job. If the respective job has
already been stored before, the given file name and the directory are kept.
The older version of the job is overwritten so that the old version can not be
restored any more.
If you have created a new job that has not been saved before, the program,
if you have clicked the save command in the file menu, goes automatically
to the command save as… .
First, the job info dialog is opened where you can enter more information
about the job. Then, the real dialog for saving your job is opened and you
are asked to enter the file name and select the directory.

CTRL+S

3.1.4 The Save as… Command

With this command you save a new job under a file name chosen by you in
a directory to be selected. This command is also for changing the file name
and / or directory of already existing files. If for example you want to save a
job that is build up on an older one without losing the old version then you
select the command save as ... and you can save the new job under
another name in a new directory if you wish to.

The command save as... is also to be selected if you want to save the
current job onto another data carrier. To do so, select the appropriate disk
drive.

SHIFT+
CTRL+S
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3.1.5 The Import… Command

With this command files are imported into CoCut. Known file formats are
shown in a list.

CTRL+I

3.1.6 The Output… Command

With this command you call the output module (Plot Manager) for cutting,
drawing or milling.

S

3.1.7 The Quit Command

With this you terminate CoCut and return to the Windows desktop. If you
have not saved the job that is currently being edited, you will be asked if you
want to do so.

CTRL+Q

3.1.8 The Job History

The Job History function facilitates the loading of the 4 last jobs without
having to pass via the directory tree. At the end of the menu list of the file
menu the names of the 4 last edited jobs appear. Click with the mouse
button on the desired job name. Then, the selected file will be loaded on the
working surface.

3.1.5 The Import… Command
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3.2 The Edit Menu

3.2.1 The Undo Command

With this command it is possible to undo the last done operations and
functions. The default setting is 5 steps. This default value can be changed
via the settings menu, menu entry standard settings / miscellaneous and
here undo levels. The maximum value is 100 steps.

Indication: This setting can only be changed with a new file (file menu,
menu item new)!

F5

3.2.2 The Redo Command

This command is the reverse command to undo. It restores the status that
was there before the undoing.

F6

3.2.3 The Cut Command

With this command objects are copied to the Windows clipboard and deleted
from the working surface. Via the clipboard objects can be inserted at
another place or in another program.

Indication: For the transport of your data you can also use the export
command. This is always necessary if your data shall be transferred to
another computer.

CTRL+X

3.2.4 The Copy Command

With this command marked objects are copied to the clipboard without
deleting them from the working surface.

CTRL+C

3.2.5 The Paste Command

This command inserts graphics and objects from the clipboard to your job.
The mouse cursor changes to a right angle in which insert is written.

Now point the tip of the right angle to the point on your working surface
where the graphic or the object shall be inserted.

CTRL+V

3.2.6 The Paste Special... Command

Via this menu item "pictures" can be imported from the clipboard to CoCut.

Indication: If in CoCut objects are copied this menu item is not active.

3.2 The Edit Menu
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3.2.7 The Select All Command

With this command all objects of the active job which means all objects on
the working surface and also outside the working surface are marked. The
selected objects can then be grouped, combined or moved.

CTRL+A

3.2.8 The Reverse Selection  Command

With this command all non-selected objects are selected. Already selected
objects will be unselected.

SHIFT+E

3.2.9 The Multi Copy… Command

This command serves the generation of any number of object copies (duplicates) on the
working sheet. Number, Offset and more can be set in a dialog.

Detailed description: please refer to 5.4: The Object Parameter Toolbar

3.2.7 The Select All Command

54



3.3 The Design Menu

3.3.1 The Rotate Axis Command

This command rotates the marked objects at 90° counter-clockwise.
This option is always necessary if you want to adjust your objects fast to the
rolling direction of the foil without having to go via the rotate function.

A

3.3.2 The Rotate Axis With Page Command

This command rotates the marked objects with page at 90°
counter-clockwise.

SHIFT+A

3.3.3 The Horizontal Mirror Command

The selected object is mirrored at its horizontal through its center point. If
several objects are marked, the center point of the virtual checkbox whose
edge is limited by the 8 black dots with the corresponding horizontal is taken
as axis of reflection. If no objects are marked all objects are mirrored.

X

3.3.4 The Vertical Mirror Command

The selected object is mirrored at the vertical through its center point. If
several objects are selected the center point of the checkbox with its
corresponding vertical is used as axis of reflection. If no objects are marked
all objects are mirrored.

Y

3.3.5 The Delete Command

Pressing the DEL key executes the delete command. In order to delete
particular objects from your graphic they must be marked.

Del

3.3.6 The Mirror on the X Axis Command

 All selected objects will be mirrored at the visible X-coordinate axis. SHIFT+
X

3.3.7 The Mirror on the Y Axis Command

 All selected objects will be mirrored at the visible Y-coordinate axis. SHIFT+Y

3.3.8 The Duplicate Command

In order to use this command the object to be duplicated must be marked
before. Now click with your left mouse button on the duplicate command or
activate it via the hotkey. The marked objects are now doubled.

CTRL+D

3.3 The Design Menu
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The positioning is done according to the values that you have entered in the
settings menu, menu item standard settings / miscellaneous.

Indication: You can also duplicate an object by first marking it, moving
it with the left mouse button kept pressed and then press the right
mouse button once at the position where the duplicate shall be
created. The displacing values are entered automatically with this
procedure.

3.3.9 The Group Command

This command allows combining several objects to a group in order to edit
them together. This can be wise if for example you want to move several
objects without changing their position to each other. To do this, first mark
all objects that you want to move together, select the group command and
then move the newly created group to the desired place. Now, it is not
possible any more to change the single objects that form the group
independently from each other. 

In order to make this possible again the grouping must be broken with the
break group command.

Indication: Grouped objects cannot be treated with the node editing
tool. The grouping must be broken before. In order to differentiate
between the grouped and ungrouped objects they are shown dashed
in blue.

CTRL+G

3.3.10 The Break Group Command

This command is used to divide a group of objects again into single object.
Each object can then be edited individually.

CTRL+B

3.3.11 The Combine Command

This command combines like the grouping several objects to one. The
difference to the group command is that the selected objects are not
regarded as single isolated objects lying next to another anymore.

Let us explain this fact with an example.

You have created two squares with different sizes, the smaller one lying
completely within the bigger one. In order to obtain that in the
full-color-mode the area of the smaller square is transparent you combine
the two squares after having marked them before. The size of the bigger
square is now interpreted as outer edge and the smaller one as inner edge.
The area between the two edges is filled with the color selected in the layer
box. In the middle, a hole with the size of the smaller square remains.

SHIFT+K

3.3.8 The Duplicate Command
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3.3.12 The Break Combination Command

With this command you cancel a combination. Now, the program treats the
combination objects as single objects again.

SHIFT+L

3.3.13 The Align… Command

With this function marked objects are aligned. You can align the objects
horizontally or vertically. The objects are arranged in that way that they are
either centered or aligned at the desired side.
In addition, the objects can be aligned with the same distance so that a
steady appearance is obtained.  It is also possible to center all objects
horizontally or vertically on the working surface.

Indication: This option can only be activated if you have marked at
least 2 objects.

R

3.3.14 The Weeding Border Command

This command generates a so-called weeding border or frame around one
or more selected objects. A weeding border facilitates weeding of the vinyl
from the carrier.

3.3.12 The Break Combination Command
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3.4 The View Menu

3.4.1 The Zoom In Command

If you select this function the mouse cursor changes into a lens with a plus
inside. You can now select an area that shall be zoomed by keeping
pressed the left mouse button. The selected area will then be shown
increased to the maximum in the program window.

Indication: A beep of the computer loudspeaker informs you that the
maximum zoom is reached.

+(NUM)
or  F2

3.4.2 The Zoom Out Command 

This function decreases the working surface gradually. If it had been
zoomed repeatedly before, the single zoom steps are carried out backwards.

-(NUM)
or  F3

3.4.3 The Full Page Command

Select the function so that the whole available working surface is shown. B

3.4.4 The Show All Command

This function changes the display of the vector drawing in this way that all
objects can be seen in the program window. The section is chosen in that
way that it is the biggest possible display of the graphic showing all objects.

Indication: If you keep pressed the SHIFT key while doing this
command only the marked objects are zoomed to maximum.

F4

3.4.5 The Show Selected Objects Command

If this command is activated only the objects marked on the working
surface are displayed as big as possible.

SHIFT+F4

3.4.6 The To Front Command

If you have arranged several objects on top of each other the following
commands enable you to modify the location of the objects to each other.
With the to front command the marked object is set on the top place above
the others.

CTRL+O

3.4 The View Menu
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3.4.7 The To Back Command

With this command you set the marked object underneath respective behind
all other objects.

CTRL+U

3.4.8 The Forward One Command

This command sets the marked objects further front in the display. PgUp

3.4.9 The Back One Command

With this command you set the marked object further down and thus further
back in the display.

PgDn

3.4.10 The Reverse Order Command

The order of the objects in the stack is reversed. What was lying on top then
lies at the bottom and vice versa. This also applies for all objects
in-between.

U

3.4.11 The Change Order Command

With this command you can change the order of the objects in the display
interactively by clicking the object contours one after another in the desired
order.

Note: If all contours are to be taken into account, the grouping of the
objects must be broken or the combination of the objects must be
broken as well.

SHIFT+R

3.4.12 The Contour View Command

This command switches the display of the working surface to the contour
mode which means that only the contours of the objects are shown.

F9

3.4.13 The Enhanced View Command

With this command you can obtain the best possible display of the objects
(smoothened contours).

Indication: It slows down the speed of processing and should
therefore only be used for the last check or presentation.

SHIFT+F9

3.4.7 The To Back Command
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3.4.14 The Always on top Command

The CoCut window remains always in the foreground.

Indication: This menu item is only active if the CoCut window is in the
window mode.

CTRL+Y

3.4.15 The Refresh Screen Command

With this function the content of the visible window is build up again without
changing the size or the selected section.

Indication: Use this command if objects on the screen are visible that
cannot be accessed by the arrow tool or if display errors of another
kind occur.

CTRL+W

3.4.14 The Always on top Command
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3.5 The Settings Menu

3.5.1 The Standard Settings Menu

Fig. 3.5-1: Default Settings dialog - here: Miscellaneous tab is active

3.5.1.1 The Miscellaneous… Setup

3.5.1.1.1 Duplicate values

- X offset

Indicates the value that remains between the original and the duplicate (in
X-orientation) after the creation of a duplicate.

- Y offset

Indicates the value that remains between the original and the duplicate (in
Y-orientation) after the creation of a duplicate.

- Dynamic adaptation Option

This option takes care of the switching on or off of a function that
automatically enters and uses the duplication values as X- or Y- orientation
when duplicating with the right mouse button.

3.5.1.1.2 Move objects

CTRL+J

3.5 The Settings Menu
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- X increment

Indicates the value how much the marked objects are moved or displaced
when pressing the arrow keys on the keyboard.

- Y increment

Indicates the value in Y-orientation how much the marked objects are moved
or displaced when pressing the arrow keys on the keyboard.

Indication: If you keep pressed the SHIFT key during the movement,
the value of the displacement is reduced to a tenth part. If you keep
pressed the SHIFT + CTRL key the displacement is a hundredth of the
set step size.

3.5.1.1.3 Undo function

- Max. undo levels

Refers to the undo function in the edit menu.

Indication: This option can only be set if no job is loaded.

- No undo / redo for bitmaps larger than ... MB

For bitmaps that are bigger than the value set in this field the
undo/redo-function is automatically switched off which means that the
operations on this bitmap cannot be made undone.

Advantage: saving of time.

Reason: The expenditure of time (computational expenditure) for bitmaps
from a specific size onwards becomes too big as for every undo / redo step
a copy of the original (initial state) must be created.
The value that is entered in this field should be between 5-10% of the RAM
available in the computer.

3.5.1.1.4 Program start

- Info window

When the program is started, an information window is displayed in front of
the workspace, which informs about news, updates, etc., if there is a
connection to the Internet.

The 3 options are: Display always, Do not show again, Only display
when new.

Recommendation: With „Only display when new” you do not miss any
important information regarding CoCut.

3.5.1 The Standard Settings Menu
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3.5.1.2 The Mouse… Setup

3.5.1.2.1 Mouse action

- <Ctrl> + right mouse button assigned with:

Here, you can define the assignment of the right mouse button. To do this,
open the selection list and select the command that shall be carried out
when clicking once with the right mouse button.

- Click Delay

This option increases the accuracy when selecting objects. The default
value is 100; the unit is millisecond. The higher this selected value the
longer it takes until the object follows the mouse cursor. An accidental
displacement of the objects is thus decreased.

Note: Users that are not so sure with the handling of the mouse should
increase this value.

- Scroll window automatically Option

This option is switched on by default and takes care that whenever an object
is moved above the edge of the working surface with the mouse, the working
surface automatically is moved, scrolled.

3.5.1.2.2 Mouse Wheel

These options ease the navigation on the CoCut desktop with computer
mice, which are equipped with a mid-wheel button. 

- <Shift> toggles these modes

Two modes are possible: Zoom or Vert. Scroll.

Zoom

This option - starting from the cursor position - increases or decreases the
working area when turning the mouse wheel: according to the direction of
rotation.

Scroll vert.(ical)

This option - starting from the cursor position - moves the working area
horizontally (Wheel + CTRL key) or vertically when turning the mouse wheel.
According to the direction of rotation the movement is done to the left, top or
bottom or to the right, top or bottom.

3.5.1 The Standard Settings Menu
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- Resolution

The sensitivity of the wheel can be adapted to individual requirements. The
range is from 1 (coarse) to 10 (fine).

3.5.1.3 The Output Devices… Setup

This category of the basic settings allows the definition of important
parameters for the output on the output device. The default settings
correlate with the information in the output dialog before the output of the job
data to the connected device.

Current output device

All currently connected output devices can be selected in this window. The
driver name, file name, and the port interface are displayed. Mode and
material from the material database can be determined.

The … button enables the creation, modification and deletion of the settings.

Port

Indicates with which computer interface the output device is connected.

Default Settings

Keep reference point

This option takes care that no new origin is set after the output of a job. The
next output is done at the same coordinates as the previous.

Stack processing

This option enables an uninterruptible output without an interaction of the
Plot Manager.

Wait after segment

Waiting after segment indicates if the cutter shall remain at this position after
the output of a cut segment. This option is typically needed with flatbed
devices without integrated automatic foil transportation.

Segment thus indicates the maximum addressable area that can be
processed in one piece.

After the segment the foil is forwarded by hand to the correct position.

Sort before output

Sort means that all inner objects are processed before the outer objects and
that a sortation is done in x-axis-orientation. This switch takes care that the

3.5.1 The Standard Settings Menu
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foil is moved as little as possible in order to maintain the repeat accuracy as
high as possible. This option is especially necessary with cutters with friction
roll drive or when milling.
The output speed is slightly reduced with this setting.

Plot to file

This option does not lead the output of the data to the connected device but
opens a dialog in which the path and the name of an output file can be given
that will be saved to the hard disk.

Read out automatically

This option can be activated if a device is connected and "online" and a read
out command for this device exists in the driver.

Output only tool-assigned layers

This option takes care that only objects are output where a tool assignment
to a layer was done.

Weeding border

This option defines if and with which distance a weeding frame is cut around
the output objects. This option facilitates the weeding of foil.

Overlap

It defines the overlapping of two segments. This value takes for example
care of the compensation for the shrinking that occurs with foils.

Copy spacing

Copy distance defines the distance of copies on the output medium.

Segment spacing

Segment distance defines the distance between single segments of a job.

Stack spacing

Stack distance defines if copies shall be stacked vertically. Requirement for
the activation of this option is that the selected object can be output more
than once on top of each other.

Indication: In the output-preview the first object is shown "normally".
Each further object of the stack is shown with a black square filled with
an X.

3.5.1 The Standard Settings Menu
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No tooltips

This option takes care that no tooltips that were entered in the device driver
are shown in the output dialog.

Enable output for objects larger than page size

This option causes objects to be passed to the output module that are larger
than the dimensions of the working area.

3.5.1.4 The Import Setup

The setup import dialog is used to preset all import filters implemented in CoCut. The
settings are divided into 4 categories for the sake of clarity. Settings made in the General
tab apply to all import filter file formats listed in the left column. Default settings are
already activated. Settings other than the standard can be activated by clicking on the
respective file format tab. The filter-specific settings can be activated or deactivated as
required.

Fig. 3.5-2: Import dialog with closed category structure and import filter file formats

Fig. 3.5-3: Plus sign control

Fig. 3.5-4: Minus sign control

Fig. 3.5-5: Check control

3.5.1 The Standard Settings Menu

66



A click on the plus sign control opens the desired category. A click on the minus sign
control closes the desired category. Clicking on the check control activates or
deactivates the corresponding option.

Fig. 3.5-6: Import dialog with opened category structure - here: General tab active

3.5.1.4.1 The Settings

3.5.1.4.1.1 Job preparation

- Assume file name as job name

This option takes the name of the import file for the job file. This makes it easier to assign
source file to job file.

- Create new job

(Default: set) - When importing foreign data, the data is imported into a job without a name
(untitled.job).

and

- close active job

The active job is closed during import. This prevents the job history becoming very large
and confusing when importing many files.

- Load following palette:

Enabling this option allows you to load a color palette with the *.PAL file extension.

3.5.1 The Standard Settings Menu
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- Load following job template:

Enabling this option allows you to load a template with the file extension *.JTP.

- Run the following macro before importing:

This option lists all available macros. This option allows data operations to be performed
before importing, such as 90° rotation, sorting with simulation, etc.

3.5.1.4.1.2 Conversions

- Separate layers by name

When importing external data, it may happen that several layers have an identical color
value. If they are assigned different names, CoCut can separate them during import and
place the corresponding objects in separate layers.

- Insert objects at position

If this option is activated, it is possible to determine the position in X and Y in which the
data is stored on the work surface.

- Combine objects in the same layers

If this option is activated, all closed objects that are in the same layer are combined during
the import.

- Group all objects

If this option is activated, all objects are grouped during import. Advantage: The position of
the objects remains unchanged when the objects are moved because only one group
object is moved.

- Rotate objects by the following angle:

The value specifies the angle at which the objects are rotated when they are imported.
Negative values are allowed.

- Scale objects by the following factor:

The value specifies the extent to which the objects are scaled, i.e. enlarged or reduced,
during import. Negative values are allowed.

- Mirror objects as follows:

This option allows the objects to be mirrored when they are imported: Possible settings
are: horizontal axis, vertical axis, both axes.

- Drag'n Drop objects rotate at the following angle:

3.5.1 The Standard Settings Menu
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If objects are dragged to the CoCut work surface, they are rotated by the entered value
when released.

- Search / replace alignment marks in the following layers:

This option searches in the selected layer for vector objects that have the size of the
alignment marks (see Standard Settings / Register / Crop Marks / Size) and convert them
into alignment mark objects, that is, these objects get the object attribute: alignment
mark.

- Resume video marks from the following layers:

(Default: set) This option takes the objects from the layers with the layer name, e.g.
Regmark; Regmarks; Register; Reg; and regards them as video marks, that is, these
objects get the object attribute video mark. 

3.5.1.4.1.3 Object properties

- Assign "Fixed object size"

If this option is activated, all imported objects are marked with the object attribute "fixed
object size"; Thus size change is deactivated

- Assign "Fixed object size at the output"

If this option is activated, all imported objects are marked with the object attribute "fixed
object size at the output". If this option is active, then no size compensation takes place
during output. The objects are placed and rotated only after the marks have been
imported.

- Assign "Do not move"

If this option is activated, all imported objects are marked with the object attribute "Do not
move". The Do not move option prevents the selected object from being moved. The
position is locked.

-  Keep object sorting

If this option is active, the object sorting is not changed during the import. The sequence of
objects will remain.

3.5.1.4.1.4 Edit objects

- Reduce nodes

Enabling this option removes all superfluous nodes. The vector object is reduced by those
nodes whose removal does not influence the curve trajectory.

- Remove duplicate lines with the following tolerance automatically:

If this option is activated, all identical, overlapping lines are automatically removed.

3.5.1 The Standard Settings Menu
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- Automatically close objects with the following tolerance:

If this option is activated, all vector objects are automatically closed or connected during
import, whose distance from the start and end point is within the closing tolerance.

- Run the following macro after import:

This option lists all possible macros. This option allows operations to be performed after
importing, such as 90° rotation, sorting with simulation, etc.

3.5.1.4.2 The Settings

3.5.1.4.2.1 AI/EPS

Default filename extensions

here: *.AI, *.EPS

Additional filename extensions

For the standard endings, individual file extensions can be specified. The import filter is
configured as in the standard version.

Use Ghostscript

If this option is activated, the open-source interpreter application named Ghostscript is
used for the data preview and the import process.

3.5.1 The Standard Settings Menu
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3.5.1.4.2.2 CUT

Default filename extensions

here *.CUT

Additional filename extensions

For the standard endings, individual file extensions can be specified. The import filter is
configured as in the standard version.

Units

Here you define in which unit the data is imported: automatic, metric or english.

3.5.1.4.2.3 CDR/CMX

3.5.1 The Standard Settings Menu
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Default filename extensions

here *.CMX, *.CDR, *.CDT

Additional filename extensions

For the standard endings, individual file extensions can be specified. The import filter is
configured as in the standard version.

3.5.1 The Standard Settings Menu
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3.5.1.4.2.4 DXF

Default filename extensions

here *.DXF

Additional filename extensions

For the standard endings, individual file extensions can be specified. The import filter is
configured as in the standard version.

Substitute font when importing text

Here you can select which font is used during the text import. The selection lists all fonts
installed on the import computer.

Units

Here you define in which unit the data is imported: automatic, metric or english.

3.5.1.4.2.5 ACM, Gerber, GTP, HPGL, JOB, OXX, ONYX, OXF

see CDR/CMX

3.5.1.4.2.6 PDF

3.5.1 The Standard Settings Menu
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Default filename extensions

here *.PDF

Additional filename extensions

For the standard endings, individual file extensions can be specified. The import filter is
configured as in the standard version.

No page selection dialog

Activating this option suppresses the page selection dialog.

Import as bitmap

Enabling this option will not import the vector data contained in the PDF file, but the
bitmapped image also included.

Ignore images

This option ensures that any existing photos are not imported.

Ignore text

This option ensures that any existing texts are not imported.

Import all pages

This option ensures that all page breaks are ignored and that the document is imported as
a whole.

3.5.1 The Standard Settings Menu
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3.5.1.4.2.7 SVG, DMPL, ZCC

see CDR/CMX

3.5.1.5 The Profile... Setup

The Profile... setup serves the customization of the desktop. The user or administrator
can adapt the CoCut interface to fit his needs or restrict it to its necessary amount. The so
defined user profile can be exported or be transferred - provided with a password
protection - onto other licensed client computers.

3.5.1.5.1 Presentation

The following options are possible: Original, XP, Icy, Office (colored). Changes
are executed directly.

3.5.1.5.2 Color

The following options are possible: Blue, Siver, Olive, and Red. Changes are executed
directly.

3.5.1 The Standard Settings Menu

75



3.5.1.5.3 Menu Icons

Possible sizes are: Small, Medium and Large. A preview in the left hand area of the
dialog shows, what effect the changes have.

3.5.1.5.4 Toolbar Icons

Possible sizes are: Small, Medium and Large. A preview in the left hand area of the
dialog shows, what effect the changes have.

3.5.1.5.5 Lock Dialog with Following Password Option

If here a password is assigned, this password is queried while the activation of the Profile
Menu Item. Changing the view is only possible with the known password.

3.5.1 The Standard Settings Menu
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3.5.1.5.6 Export Profile Button

Fig. 3.5-7: Save profile dialog with default path

Enabling of the Export Profile button allows saving of customize CoCut profiles. The used
file extension is *.EC7. As default *.EC7 files are saved in the folder, where the program
data are located.

Note: If all menus or the settings menu were accidentally disabled, then access on
the profile resp. profile file is possible using the sytem menu. The system menu is
enabled with a click on the program logo, which you'll find left from the program
name in the program bar.

Fig. 3.5-8: System menu with Profile… sub menu

3.5.1 The Standard Settings Menu
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3.5.1.5.7 Status Area

In the status area messages and infos are displayed that explain the program's operation.

3.5.2 The Working Area… Command

Fig. 3.5-9: Working area with shadows and rulers

Here, you can newly define the size and color of your working area. The
working area is displayed as a paper frame with a gray shade on the right
and bottom next to the frame (see figure above). The color of the working
area is freely definable; this guarantees an optimal layout control on the
screen.
Pre-defined are for example DIN-A-sizes. Besides the fix defined measures
you can define any number of user-defined working area. One can be
defined as standard. It will then be pre-set at every "file new".
This option is a very helpful function for everybody who has e. g. a milling or
an engraving machine as the new entry in each case of the usable area can
be omitted.

Indication: A double click on the shade right next and below the
working area also opens this dialog.

3.5.1 The Standard Settings Menu
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3.5.3 The Rulers… Function

With this function you define the positions where the rulers shall be
placed. Due to lack of space the display of the rulers can be
abandoned. With diametric display each 5th step is drawn longer and with
non-diametric each 2nd and each 4th once again.

SHIFT+I

3.5.4 The Unit of Measurement Function

This instruction switches the measuring unit to the preferred unit (mm, cm or
inch).

Indication: The metric can also be changed directly via a button that is
in the angle of both rulers.

3.5.5 The Origin Function

This function shows a zero point (origin) in the lower left corner or the lower right corner of
the working area. It is used for orientation on the working area. Which view is preferred
depends mostly on the zero point of the connected machine. The view on the working area
then corresponds to the real conditions.

Fig. 3.5-10: Here: Origin bottom left

3.5.5.1 The Settings Origin Menu

3.5.3 The Rulers… Function
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Fig. 3.5-11: The Origin Options

3.5.5.1.1 Setup...

Fig. 3.5-12: The origin dialog box

New Position (X / Y)

This option allows you to set the zero point using specific values.

X Field + Measuring Unit

In the X field, the absolute coordinate of the zero point on the X-axis can be specified.

Note: The unit depends on the setting of the ruler.

Y Field + Measuring Unit

In the Y field, the absolute coordinate of the zero point on the Y-axis can be specified.

Note: The unit depends on the setting of the ruler.

Display as Cross Option

If this option is activated, the origin point is represented by a dashed coordinate cross. If
the option is deactivated, the position of the zero point is only taken into account in the
rulers.

3.5.5 The Origin Function
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Bottom Left Option

This option places the zero point in the lower left corner of the working area. 

Bottom Right Option

This option places the zero point in the lower right corner of the working area.

3.5.5.1.2 Move

This command serves to move the ruler origin. The Move option activates a crosshair as
a mouse cursor. With the help of this, the zero point can be moved to any individual
position.

3.5.5.1.3 Reset

The Reset option returns the zero point to the original position (lower left or lower right).

3.5.5.1.4 Center to page

This command serves to move the origin point to the center of the working area (center of
page).

3.5.5.1.5 Center to selection

The Center to selection option sets the zero point to the position of the middle handle
located at the center of a selected object.

Note: This command is selectable only, if one or more objects are selected on the
desktop.

3.5.5.1.6 To selected node

The To selected node option sets the zero point to the position of a marked (selected)
node.

Note: This command is selectable only, if one or more objects are selected on the
desktop.

3.5.5.1.7 Display

This option displays the zero point or makes it invisible.

Note: Only visible, if the Display as Cross-Option is active.

3.5.5.1.8 Fix

This option makes the zero point moveable or fixes it at the current position. 

3.5.5 The Origin Function
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3.5.6 The Undo / Redo Command

With this instruction the undo / redo function can be switched on or off.

Advantages when undo / redo switched off:

With big or many objects the node processing is faster. The testing phase
(initial state -> edition -> temporary final state) with several processing
steps can be made undone as follows:
1. Switch off undo/redo, 2. edit objects and 3. switch on undo / redo

The selection of the undo function in the edit menu reestablishes the state
before point 1.

SHIFT+F7

3.5.7 The Snap Mode Function

The snap mode facilitates the creation of objects at the subsidiary lines. This
option activates the "magnetic" effect on graphic objects and text blocks.

P

3.5.8 The Choose Language… Command

This option sets the language for user interface and help file.

3.5.8.1 Program Language

The user interface language is set here.

3.5.8.2 Language for the Help File

The language for the help is determined here.

3.5.6 The Undo / Redo Command
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3.6 The Window Menu

3.6.1 The New Window Command

Activating this instruction opens a new CoCut window.

3.6.2 The Tile Horizontally Command

The activation of this instruction places all open windows diminished - one
above the other - horizontally.

3.6.3 The Tile Vertically Command

The activation of this instruction positions all opened windows diminished  -
side by side - vertically.

3.6.4 The Cascade Command

The confirmation of this instruction displays all windows diminished and
cascaded (diagonally displaced).

3.6.5 The Close Command

Clicking this instruction closes the momentarily active window after prior
safety query.

3.6.6 The Close All Command

Clicking this instruction closes all open windows after prior safety query.

3.6.7 The Standard Command

This command switches the tool-toolbar on the desktop or makes it
disappear.

CTRL+1

3.6.8 The Setup Command

This instruction switches the setup toolbar on the desktop or makes it
disappear.

CTRL+3

3.6.9 The Common Tools Command

This instruction switches the common tools toolbar on the desktop or
makes it disappear.

CTRL+4

3.6 The Window Menu
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3.6.10 The Object Tools Command

This instruction switches the object tools toolbar on the desktop or makes it
disappear.

CTRL+6

3.6.11 The Object Parameters Command

This instruction switches the object parameters toolbar on the desktop or
makes it disappear.

CTRL+7

3.6.12 The Status Bar Object Info Command

This instruction switches the status bar object info toolbar on the desktop
or makes it disappear.

CTRL+8

3.6.13 The Status Bar Element Info Command

This instruction switches the status bar element info on the desktop or
makes it disappear.

CTRL+9

3.6.10 The Object Tools Command
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3.7 The Help Menu

3.7.1 The About … Command

The selection of this menu entry opens an info window in which various
information is shown. On the left part of the dialog among others the serial
number, version number, free disk space, co-processor, or type of processor
are shown. On the right down part of the dialog is a scroll window in which
all the application files of the respective application version are listed. This
file list can be printed via the print button.

Indication: If there should be problems with your CoCut version you
can fix them the fastest, if this list is made available to our support
staff.

3.7.2 The Help… Command

This option starts the CoCut help. F1

3.7.3 The Object Info… Command

The activation of this instruction opens an info window that contains
information about the objects on the desktop. These are among others the
number of objects, number of selections, vector objects, text blocks, all
groups and combinations or all bitmaps.

The selection button opens the object manager.

F10

3.7.4 The Install Autoimport Plug-Ins… Command

Enabling this command opens the Corun Installer window, that lists for
which programs plug-ins are available. Programs which were automatically
found are marked already. Select the target program for the intended data
exchange in the Eurosystems Software list field.

Pressing the Install button starts the installation.

please refer to 1.2.1: Corun Installer

3.7.5 The Online Support Command

The activation of this menu item establishes a direct internet connection to
the support page of the EUROSYSTEMS S.à.r.l. - www.eurosystems.lu.

3.7 The Help Menu
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3.7.6 The Remote Support… Command

Via remote control the content of the screen of a computer can be
transferred in realtime to another computer. Thus it is possible that two
users who are at different places look at the same desktop. While you are on
the telephone with our consultant (support) you can show each other
documents or applications even if you are far apart from each other in
reality. The direction of transmission respective line of vision can be
changed with a mouse click. Thus you can choose if you want to look
together at your screen or at the screen of your consultant.
In order to be able to use the remote support you need an active internet
connection.

3.7.7 The Live Update Command

This instruction activates a software update via internet.

Indication: Requirement is an active internet connection on the
computer where the software is installed.

3.7.6 The Remote Support… Command
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3.8 Context Menu Left Mouse Button

3.8.1 Context Menu Ruler

3.8.1.1 The Unit Button

A click on the Unit button activates one of the following context menus:

Note: Which of the two is enabled, depends on whether objects are selected on the
working area and what zero point setting is active.

 or 

3.8.1.1.1 Origin…

please refer to 3.5.5: The Origin Function

3.8.1.1.2 Move Origin

This command serves to move the ruler origin to any position on the desktop.

3.8.1.1.3 Reset Origin

This command serves to move the origin point into the lower left corner of the working
area.

3.8.1.1.4 Set Origin to Center of Page

This command serves to move the origin point to the center of the working area (center of
page).

3.8.1.1.5 Set Origin to Center of Selection

This command serves to mirror or place objects at the coordinate axis.

Note: This command is only visible, if one or more objects are selected on the
working area.

3.8 Context Menu Left Mouse Button
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3.8.1.1.6 Hide Origin

This command serves to switch the ruler zero point to invisible.

3.8.1.1.7 Release Origin

This command serves to release the fixation of the ruler origin in order to move it with the
mouse.

3.8.1.1.8 Show Origin

This command serves to switch the ruler zero point to visible.

3.8.1.1.9 Fix Origin

This command serves to anchor the ruler zero point at a definite point.

3.8.1 Context Menu Ruler
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3.9 Context Menus Right Mouse Button

3.9.1 Context Menu on Empty Working Area

Fig. 3.9-1: This menu appears if no objects lie on the desktop

Job Properties…

This command opens the following Job properties dialog:

Fig. 3.9-2: Job properties dialog with job infos

Do not sort during output

This option prevents, if activated, the objects being sorted before or during output. In other
words, the original object sorting is retained.

Note: If this option is activated, the "Do not sort during output" option located in the
output dialog is automatically deactivated.

Refresh screen

This instruction refreshes the active window.

3.9 Context Menus Right Mouse Button
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Import…

This menu entry opens the import dialog for the import of external file formats.

Insert

This menu entry inserts contents from the Windows clipboard to the CoCut working area.

Working area

This menu entry opens the dialog for the pre-setting of the parameters of the working area.

Fit Page to Objects

This option scales the working area proportionally in relation to the object size.

3.9.1 Context Menu on Empty Working Area
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4 Reference Part Output Preview

4.1 The Output Menu

4.1.1 The Output Command

Starts the output on the connected device with the settings of the output to device
dialog.

4.2 The Options Menu

4.2.1 The Save As… Command

The save as… command in the output preview ... saves the job
with all changes that were done in the preview. When returning to
the working surface all these settings would be lost, therefore, the
job can here be saved under another name.

please refer to 3.1.4: The Save as… Command

SHIFT+CTRL+S

4.2.2 The Rotate Axis Command

This command rotates the marked objects at 90° counter-clockwise.

please refer to 3.3.1: The Rotate Axis Command A

4.2.3 The Horizontal Mirror Command

The selected object is mirrored at the horizontal through its center-point.

please refer to 3.3.3: The Horizontal Mirror Command X

4.2.4 The Vertical Mirror Command

The selected object is mirrored at the vertical through its center-point.

please refer to 3.3.4: The Vertical Mirror Command Y

4.2.5 The Optimization… Command

The foil optimization takes care that all objects are arranged in a way that they take the
least space on the foil. By rotation or no rotation of objects it is taken care of, that the
material waste can be decreased.
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please refer to 2.5.1.1: Foil optimization

4.2.6 The Recalculate Command

The recalculate command enables the modification of the
output-parameters or of the driver settings without leaving the output routine.

This command switches back from the output preview to the output dialog.

N

4.2.7 The Initial View Command

Puts back the output preview to the status before having pressed the
preview button in the output dialog. All changes are made undone. 

SHIFT+N

4.2.8 The Horizontal Weeding Lines Command

Weeding lines serve for the better processing of big jobs. Material lengths of
several meters in length or width are difficult to handle, therefore you can
insert weeding lines during the foil cutting that divide the job into smaller
parts that are easier to handle.

The horizontal weeding lines are set with the hotkey "h" or drawn with the
arrow from the weeding frame dashed in blue.

please refer to 2.5.1.2: Weeding lines

H

4.2.9 The Vertical Weeding Lines Command

Weeding lines serve for the better processing of big jobs. Material lengths of
several meters in length or width are difficult to handle, therefore you can
insert weeding lines during the foil cutting that divide the job into smaller
parts that are easier to handle.

The vertical weeding lines are set with the hot key "v" or drawn with the
arrow from the weeding frame dashed in blue.

please refer to 2.5.1.2: Weeding lines

V

4.2.10 The Test Drive Command

If the test drive command is activated the connected device goes with lifted tool head
along the weeding frame. This also happens if the option "weeding frame" was not
activated.

4.2.5 The Optimization… Command
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Compare test drive button in the output dialog please refer to 2.4.3: Start Output
from the CoCut Working Surface

4.3 The View Menu

4.3.1 The Material Width Command

When activating this command the section is adjusted to the values for the
material width defined in the driver or set in the output dialog.

B

4.3.2 The All Objects Command

This function changes the display in that way that all objects can be seen on
the screen. The section is selected so that it is the biggest possible display
showing all objects.

If the SHIFT key is pressed while activating this command, only the selected
objects are zoomed to maximum.

F4
and

SHIFT+F4

4.3.3 The Selected Objects Command

If this command is activated only the selected objects from the output
preview are displayed as large as possible.  

SHIFT+F4

4.3.4 The Total Area Command

If this menu item is activated the preview of the whole material surface is
shown.
The size of the shown surface depends on the so called frame size (foil
height x foil width) of the output device to be accessed.
If in the output dialog a driver for a friction feed cutter was selected, in the
preview always a material length of 30m (32,81 yd) is shown. 
If in the cutting dialog a driver for a flatbed cutter was selected, the
maximum width of the flatbed cutter is shown as material length.

SHIFT+B

4.4 The Window Menu

4.4.1 The New Window Command

Activating this instruction opens a new CoCut window.

4.4.2 The Tile Horizontally Command

The activation of this instruction places all open windows diminished - one
above the other - horizontally.

4.2.10 The Test Drive Command
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4.4.3 The Tile Vertically Command

The activation of this instruction positions all opened windows diminished  -
side by side - vertically.

4.4.4 The Cascade Command

The confirmation of this instruction displays all windows diminished and
cascaded (diagonally displaced).

4.4.5 The Close Command

Clicking this instruction closes the momentarily active window after prior
safety query.

4.4.6 The Close All Command

Clicking this instruction closes all open windows after prior safety query.

4.4.7 The Common Tools Command

This instruction swithes the Common Tools toolbar on or off. CTRL+4

4.4.8 The Object Parameters Command

This instruction switches the object parameters toolbar on the desktop or
makes it disappear.

STRG+7

4.4.9 The Status Bar Object Info Command

This instruction switches the status bar object info toolbar on the desktop
or makes it disappear.

CTRL+8

4.4.10 The Status Bar Element Info Command

This instruction switches the status bar element-info on the desktop or
makes it disappear.

CTRL+9

4.5 The Help Menu

4.5.1 The About … Command

The selection of this menu entry opens an info window in which various
information is shown. On the left part of the dialog among others the serial
number, version number, free disk space, co-processor, or type of processor

4.4.3 The Tile Vertically Command
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are shown. On the right down part of the dialog is a scroll window in which
all the application files of the respective application version are listed. This
file list can be printed via the print button.

Indication: If there should be problems with your CoCut version you
can fix them the fastest, if this list is made available to our support
staff.

4.5.2 The Help… Command

This option starts the CoCut help. F1

4.5.3 The Install Autoimport Plug-Ins… Command

Enabling this command opens the Corun Installer window, that lists for
which programs plug-ins are available. Programs which were automatically
found are marked already. Select the target program for the intended data
exchange in the Eurosystems Software list field.

Pressing the Install button starts the installation.

please refer to 1.2.1: Corun Installer

4.5.4 The Online Support Command

The activation of this menu item establishes a direct internet connection to
the support page of the EUROSYSTEMS S.à.r.l. - www.eurosystems.lu.

4.5.5 The Remote Support… Command

Via remote control the content of the screen of a computer can be
transferred in realtime to another computer. Thus it is possible that two
users who are at different places look at the same desktop. While you are on
the telephone with our consultant (support) you can show each other
documents or applications even if you are far apart from each other in
reality. The direction of transmission respective line of vision can be
changed with a mouse click. Thus you can choose if you want to look
together at your screen or at the screen of your consultant.
In order to be able to use the remote support you need an active internet
connection.

4.5.6 The Live Update Command

This instruction activates the update of the software via the internet.

Indication: Requirement is an active internet connection on the
computer where the software is installed.

4.5.1 The About … Command
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4.6 Context Menu of The Right Mouse Button

4.6.1 Context Menu Output Preview

Fig. 4.6-1: Context menu of the output preview with weeding frame function

Weed border

This function creates a weeding frame around the selected objects in the output preview
unlike the weed border option.

All other menu entries can be activated via the main menu.

4.6 Context Menu of The Right Mouse Button
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5 Toolbars

5.1 The Standard Toolbar

The standard toolbar is switched on or off via the window menu. CTRL+1

Fig. 5.1-1: Freely placeable toolbar - Collection of standard tools

Fig. 5.1-2: Fixed standard toolbar

BUTTONS FROM 1 TO 15

1. Create New window 9.  Print objects
2. Open job 10. Import file
3. Save job 11. Export objects
4. Save all 12. Scan image
5. Edit job info 13. Undo
6. Cut to Clipboard 14. Redo
7. Copy to Clipboard 15. Help
8. Paste from Clipboard

5.2 The Setup Toolbar

The Setup toolbar is switched on or off via the Window menus. CTRL+3

Fig. 5.2-1: Free placeable Setup toolbar

Fig. 5.2-2: Fixed Tool Bar

BUTTONS FROM 1 TO 2

1. Contour mode on/off
2. Desktop Setup

Indication: Alternatively the work area can be defined by doubleclick on the shades
beside the work surface.
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5.3 The Object Tools Toolbar

The Object Tools toolbar is switched on or off via the WIndow menu. CTRL+6

Note: This is the section which in former CoCut versions (right mouse click for icon
assignment) was the variable section of the object toolbar. 

Fig. 5.3-1: Freely placeable toolbar - collection of objcet tools

Fig. 5.3-2: Anchored toolbar

BUTTONS FROM 1 TO 21

1. Delete Objects 12. Open Objects
2. Do Axis Change with Objects 13. Round Objects
3. Horizontal Mirror of Selected Objects 14. Delete Redundant Nodes
4. Vertical Mirror of Selected Objects 15. Vectorize Objects
5. Group Objects 16. Generate Contour Line
6. Ungroup Objects 17. Start Foil Optimization
7. Combine Objects 18. Set Start Tool Paths
8. Release Combination of Objects 19. Hatch Objects
9. Generate Block Shadow 20. Generate Out- or Inlines
10. Align Objects 21. Weld Objects
11. Close Objects

5.3 The Object Tools Toolbar
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5.4 The Object Parameter Toolbar

Fig. 5.4-1: Freely placeable toolbar - collection of object parameters

Fig. 5.4-2: Object parameters toolbar with explanations

5.4.1 The Multi Copy Command

Definition: Multi Copy = Multiple copies of selected objects (Duplicates)

5.4.1.1 The Multi Copy Button

Pressing the button opens the following dialog:

5.4.1.2 Copies X:

Using the  or  button the number of duplicates can be increased or decreased in
increments of one. The alignment is done in the Main Direction. Alternatively, any integer
value may be entered in the field.

5.4 The Object Parameter Toolbar
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5.4.1.3 Copies Y:

Using the  or -button the number of duplicates can be increased or decreased in
increments of one. The alignment is done in the Main Direction. Alternatively, any integer
value may be entered in the field.

5.4.1.4 Offset X:

This value determines the distance between the duplicates in X-Axis direction.

5.4.1.5 Offset Y:

This value determines the distance between the duplicates in Y-Axis direction.

5.4.1.6 The Select Objects Option

If this option is enabled, all duplicates will be selected finally. 

5.4.1.7 The Fill Working Area Option

If this option is enabled, then the working sheet only and not the desktop is filled with
duplicates.

Note: Enabling this option, de-activates the Copies X and Copies Y fields.

5.4.1.8 The Create Clones Option

If this option is enabled, then the selected object is uses as control object for cloning. All
duplicates are generated as clone objects.

5.4.1.9 The Group Result Option

Enabling this option groups all duplicates finally.

5.4.1.10 The Optimize Traverse Path Option

If this option is enabled, duplicates are generated in meanders. This reduces the head
movement of the output device and shortens the output process.

Note: The main direction option defines additionally, if meandering is done in X-Axis
or Y-Axis direction.

5.4.1.11 The Main Direction Option

The  button sorts the duplicates in Y-Axis direction - "column by column". The
-button sorts the duplicates in Y-Axis direction - "line by line".

5.4.1 The Multi Copy Command
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5.5 The Status Line Object Info

This status line informs about the properties and attributes of objects on the CoCut
desktop. This information comprises number, type of object, color model, color value and
many other data important for the evaluation. 

Fig. 5.5-1: Status line for the display of object properties, color spaces , etc. - free floating

Fig. 5.5-2: Status line for the display of object properties, color spaces, etc. - fixed

5.6 The Status Line Element Info

This status line indicates the current mouse cursor position in x/y-coordinates. In addition,
in the left part next to the cursor coordinates subsidiary texts and additional texts from the
layer info for example from the field material name are displayed. It is also possible to
show driver information as for example the set tool depth for a particular layer.

Fig. 5.6-1: Status line element with subsidiary texts and element information, here
coordinates

5.7 The Preview Tools Toolbar

The Magnifying Glass+

The button with the (+) plus sign increases parts of the output preview. Draw
with the marking function a frame around the area that shall be increased.
This function can be carried out successively several times until a beep
reminds acoustically of the last possible step.

F2
or

+(Num)

The Magnifying Glass–

The button with the (-) minus sign decreases gradually parts of the desktop
or of the working area.

F3
or 

-(Num) 

The Sheet

The button with the symbolic sheet of paper shows the material area
increased to the maximum

 B

The Screen  F4

5.5 The Status Line Object Info
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The button that symbolizes a screen displays all objects on the material area
as big as possible. The section is thus selected that is it the biggest possible
display with all objects visible.

The Magnifying Glass for Selected Objects

The „dotted loupe” button displays all selected objects as big as possible.

SHIFT +
F4

The Output Command

The activation of this button gives the data to the Plot-Manager for the
output to the connected device.

 S

5.7 The Preview Tools Toolbar
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5.8 The Preview Object Parameters Toolbar

The preview object parameters toolbar is activated with the following
shortcut.

CTRL+7

Indication: It is identical with not variable part of the object parameters toolbar in
previous CoCut versions.

Fig. 5.8-1: Object parameter toolbar with position, size, angle, multi copy, …

Note: The display of the object parameters toolbar varies depending on how the
object properties are set!

5.8 The Preview Object Parameters Toolbar
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5.8 The Preview Object Parameters Toolbar
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6 Tools
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6.1 The Alignment Function

Fig. 6.1-1: The alignment button

This function aligns two or more marked objects to each other or to the working area.

Fig. 6.1-2: The alignment dialog

Objects can be aligned horizontally or vertically. A centered alignment is also possible as
the selection of the same distance between the marked objects. The type of alignment is
illustrated by icons. Setting can be stored by pressing the Save settings button.

Indication: The last marked or drawn object serves for alignment as reference
object, that means that all others are aligned in the same way. If alignment is not
'Align to Page', then alignment will refer to the last selection.

6.1 The Alignment Function
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When outputting to a connected device, the safety instructions of the
machine manufacturer must always be observed strictly.
No liability is assumed for infringement.

6.2 The Plot Manager

The Plot Manager has the following tasks:

6.2.1 Creation And Modification of Device Configurations

With the Plot Manager it is possible to create a device configuration or short, to create an
output device. In a device all information necessary for the output of the data as for
example driver and ports are summarized.

In CoCut, these devices then can be used for the output of the graphics. It is possible, to
output simultaneously at several devices.

6.2.2 Monitoring the Output Processes of the Jobs

The outputs to the respective devices can be monitored with the Plot Manager, for
example the output can be broken or aborted and the sequence of the jobs can be
changed retroactively.

6.2.3 Output of Data to Local Ports

The serial and parallel ports of the computer are identified and can be used for the file
output.

6.2.4 Administration of Hotfolders

A function independent of CoCut is the administration of Hotfolder. A Hotfolder is a
directory monitored by the Plot Manager. If a file is copied to this directory the Plot
Manager carries out automatically certain configurable functions.

6.2.5 Plot Server Function

The Plot Manager can enable devices so that other Plot Managers can use these enabled
devices. This allows separating design and output working places.

Important note:You start the Plot Manager with a double click on the  icon that is
down right of the screen in the task bar.

6.2 The Plot Manager
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Fig. 6.2-1: Plot Manager main window with job preview down left

6.2.6 Devices Folder

Each device possesses three device folders in which the jobs are shown:

Indication: with jobs, also those output actions are meant that are carried out by
Hotfolders or on local ports.

Devices Folder 1

Active Jobs
All jobs that shall be output as soon as the device is ready are collected in this folder. If a
job has been output completely, the next job is output. If the option „show message
window before output of a job” is active, a notification dialog is shown before each output.

Devices Folder 2

Passive Jobs
If the output device is broken, all jobs to be output are moved to this folder.

Devices Folder 3

 Saved Jobs
Here, all jobs that have been output are saved. The number of the saved jobs can be
indicated in the options dialog of the device. If the number of the saved jobs is reached the

6.2.5 Plot Server Function
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next one to be saved replaces the oldest existing job.

Job Functions

The functions differ according to device folder, device type and job status.

Indication: The functions can be carried out via a context menu.

6.2.6.1 Jobs at local devices

Active Jobs
If the job is being output:

Pause
The output of the data is paused. The job is marked with the symbol.

Paused Jobs

Continue
The output is continued.

Set Job to passive
The job is removed from the list of the active jobs and added to the folder of the passive
jobs.

Delete Job
The job is deleted.

Passive Jobs

Activate Job
The job is removed from the list of the passive jobs and added to the folder of the active
jobs.

Delete Job
The job is deleted.

User message: to this job, a notification text can be entered. This information is shown if
the job shall be output respective if it is selected.

Saved Jobs

Activate Job
The job is removed from the list of the output jobs and added to the folders of the passive
or active jobs depending on the setup device.

Delete Job
The job is deleted.

Plot to File
Here you can determine if the job shall be output to a file.

6.2.6 Devices Folder
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Save as
Save job data into file before cut data processing.

6.2.6.2 Jobs at Plot Servers

Active Jobs
No functions

Passive Jobs

Activate Job
The job is removed from the list of the passive jobs and added to the folder of the active
jobs.

Delete Job
The job is deleted.

User message: to this job, a notification text can be entered. This information is shown if
the job shall be output respective if it is selected.

Saved Jobs

Activate Job
The job is removed from the list of the output jobs and added to the folder of the passive or
active jobs depending to the setup device.

Delete job
The job is deleted.

Save as
Save job data into file before cut data processing.

6.2.6.3 Jobs at Hotfolders

Active Jobs
No functions

Passive Jobs

Activate Job
The job is removed from the list of the passive jobs and added to the folder of the active
jobs.

Delete Job
The job is deleted.

User message: To this job, a notification text can be entered. This information is shown if
the job shall be output respective if it is selected.

6.2.6 Devices Folder

110



Saved Jobs

Activate Job
The job is removed from the list of the output jobs and added to the folder of the passive or
active jobs depending to the setup device.

Delete Job
The job is deleted.

Save as
Save job data into file before cut data processing.

6.2.6.4 Jobs at local ports

Active Jobs
If the job is being output:

Pause

The output of the data is broken. The job is marked with the  symbol.

Paused Jobs

Continue
The output is continued.

Set Job to passive
The job is removed from the list of the active jobs and added to the folder of the passive
jobs.

Delete Job
The job is deleted.

Passive Jobs

Activate Job
The job is removed from the list of the passive jobs and added to the folder of the active
jobs.

Delete Job
The job is deleted.

Notification: To this job, a notification text can be entered. This information is shown if the
job shall be output respective if it is selected.

Saved Jobs

Activate Job
The job is removed from the list of the output jobs and added to the folder of the passive or
active jobs depending to the setup device.

6.2.6 Devices Folder
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Delete Job
The job is deleted.

Plot to File
Here you can determine if the job shall be output to a file.

Save as
Save job data into file before cut data processing.

6.2.7 Settings of the Plot Manager

Fig. 6.2-2: Optional parameters for the Plot-Manager

If the option is activated Plot Manager always on top, the Plot Manager window remains
always in the foreground.

If the option tooltips is activated, a short description to a dialog element is shown if the
mouse pointer remains above the dialog element.

If the option view job preview is activated a preview of the output data is shown.

Command line parameters

If the Plot-Manager is started without parameters it checks all devices if there are jobs for
processing.
If a job was found it is carried out. It stops if no jobs were found or if all jobs have been
processed.

If, when calling up the parameter !SPOOL! is given, the Plot Manager remains active. It
then has to be terminated manually with a right mouse click onto the symbol in the
taskbar.

Hotfolder

With a Hotfolder a directory can be monitored. If a file is copied to the directory to be
monitored one of the following actions is carried out automatically depending on the
settings:

6.2.7 Settings of the Plot Manager
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Fig. 6.2-3: Example for setup devices of a Hotfolder

Settings

Hotfolder name: here you have to enter the name of the Hotfolder

File mask: here, the file name ending are given, that shall be considered, for example *.plt.

Hotfolder directory: here, it is determined which directory the Hotfolder shall monitor.

Output

COM/LPT: the file is output to a local serial respective parallel port.

USB: the file is output to a USB device. A USB device is only shown if it is connected with
the computer.

TCP/IP: the file is send to a TCP/IP address. With some addresses, you additionally have
to enter the right port number.

Spooler: the file is output via a printer driver.

File: the file is copied to the output directory. An existing file with the same name is
overwritten.

6.2.7 Settings of the Plot Manager
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After having carried out the action, the input file is deleted.

Indication: if "file" is set as output, the application is started after the copy. In all other
cases, the application is started before the output.

Extended Settings

Start application if Hotfolder becomes active: in addition, another application can be
started that shall further process the input file to be processed. The file name is marked
with %s.

RIP: only necessary if Pjannto RIP uses this Hotfolder as RIP Hotfolder.

Mask: formatting of the output file name: %File file name; date/time: %Y -
%d_%H-%M-%S year/month/day: hour/second/minute

Change defaults: prevents that the user modifies the output parameters accidentally.

6.2.7.1 Device Options

In the Device Options window you can set - for each device which is listed in the Plot
Manager - the following device options.

Note: This window will be enabled by clicking with the right mouse button on a
device item and selecting the Options menu item.

Fig. 6.2-4: Additional options for each device

Maximal number of saved output files

The registered value of this option limits the number of saved output jobs for this device in
the history of stored files.

Number of outputs (of a Job)

The registered value of this option defines how often active Jobs will be given out.

6.2.7 Settings of the Plot Manager
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Inform user before output

If this option is enabled, then a message window will be shown, before the outputting of
each Job. This gives the user the opportunity to prepare the machine before the data
output.

Plot to File

If this option is enabled, then the output is redirected to a file. Before writing the file to the
Job Save As dialog is enabled.

Activate Sound Signal

If this option is enabled, then an individual sound signal will be given out before each
output of a Job, in order to draw attention to the user.
A sound file in the WAV file format can be selected using the  button.

The Movement... Button

Fig. 6.2-5: Distances of the used tools

This feature tracks the distance (tool motion), from every tool of the activated output
device in meters. In addition to the distance, date and time of each output are given.

6.2.7 Settings of the Plot Manager
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7 Tips & Tricks - Trouble Shooting

Often, it is just a bagatelle that makes the "implementation" of new software
difficult. Similar to a new machine, there are questions and problems with new software
that often can be explained and solved easily. Therefore, we have explained a selection of
questions that occur daily at our hotline- and support routine more closely.

7.1 Code is not accepted with Windows 7, 8, 10 or Vista (No
Dongle)

Error message: Invalid code or after each program start the code must
be entered again

The program must be executed once with aministrator rights. Click with the
right mouse button in the program menu on CoCut Starter 2017 and select
"Execute as administrator".

Note: Don't change anything on the given activation data resp. license
data.

Tip 1

7.2 Buffer Overflow Serial Port

The cutter cuts the first characters neatly and then starts to draw
indefinable curves. 

With serial activation of the cutter, this is a typical buffer overflow problem
and occurs if the protocol for the serial transfer is not set correctly. Most
cutters are activated with the following parameters with a serial data
transfer: bits per second: 9600, data bits: 8, parity: none, stop bits: 1,
protocol resp. flow control: hardware

Tip 2

7.3 Output Size Mimaki

The output size on a Mimaki cutter does not correspond with the
configured size but is more than twice as big.

The Mimaki cutter of the CG series is delivered ex works with a plot
resolution of 0.025 mm even if they can work with a resolution of 0.01 mm
and do so internally. The drivers of CoCut are set to these
„device”-resolution because the cutters can be activated faster and more
accurate.
For the adjustment of this plot resolution you switch on the cutter, press the
< button at the control panel and after the cutter has measured the roll you
press the function key until "interface" appears in the display. Then, you
press the ENTER key until you reach the menu item "Stepsize" and then the
^-button. The display now shows „0.01”. Confirm the selection with ENTER
and END.

Tip 3
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7.4 Output Size Graphtec

The output size on my Graphtec cutter does not correspond with the
configured size but is more than twice as big.

Setting the step size:

In the GP-GL mode it is possible to set the minimal distance of the cutting
knife's path to one of the following widths: 0.01 mm, 0.025 mm, 0.05 mm or
0.1 mm. The default setting is 0.1 mm. This value must be changed, if your
program's driver uses another step size.

Step 1: Switch into the command mode "GP-GL".

Step 2: Press the enter key; the menu step size appears.

Step 3: Press , key to select the desired value (0.100 mm, 0.050 mm, 0.025
mm, or 0.010 mm) and confirm with enter key. Press (NEXT) or (PREV.)
to undo your selection.

Step 4: Press (PAUSE) key in order to cancel the PAUSE mode.

In the case of controlling the plotter from CoCut, the value of the step
size must be set to 0.025. This is the resolution which is preconfigured in the
drivers.

Tip 4

7.5 Calibration of the Output Size

Problem: The size entered in the software and the output size of the
objects do not match.

Solution: Calibration must be performed on the connected cutter.
Calibration means: checking and, if necessary, changing the values stored
in the driver to the values you have measured.

Method:

Activate the following dialog in the Settings / Standard Settings / Output
Devices... menu.

Tip 5

7.4 Output Size Graphtec
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Clicking the Calibrate button opens the Calibrate Device dialog.

7.5 Calibration of the Output Size
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Now carry out the calibration step by step.

Step 1: Specify the size of the rectangle to be output. Get the cutter ready
for output. Start the output by clicking on the Rectangle button.

Step 2: Weed the rectangle and measure it with a ruler. Enter the measured
values in the Length (X) and Width (Y) fields under Measure (Step 2). Then
click on the Calibrate button. The new values are now entered into the
driver.

Note: You can repeat this process. The maximum accuracy to be
achieved depends only on the connected device. Low-cost devices
often only achieve an accuracy of +/- 0.5 mm. Professional vinyl
cutters achieve an accuracy of ≥ +/- 0.1 mm.

7.6 Computer without serial COM port

My computer provides no serial COM port, but a USB port. How can I
connect my cutting plotter, which provides only a serial interface?

In this case there is a computer accessory called - USB serial adapter-  that
provides one or more serial COM ports on one USB port.

Tip 6

7.6 Computer without serial COM port

120



Note: Not all adapters offered work properly, especially the use on
64-bit operating systems is sometimes not free from errors. It may be
that different adapters must be tried.

7.7 Cutter Does Not Respond!

a. First check if you have selected the correct cutter driver and the correct
port: for example <device name> at COM2 in the CoCut cutting dialog

b. COM connection: Check if the parameters of the port are set correctly. To
do so, call up the system control of Windows. In the device manager, select
the corresponding connection, for example: COM.

Popular standard parameter are: Baud: 9600, data bits: 8, parity: none, stop
bit: 1, protocol / flow control: hardware

The settings in the system control and at the cutter must be identical
otherwise no or only faulty data transfer will take place.

c. USB connection: Check if the correct USB driver is installed for the
device. The settings are in the Windows device manager under USB
controller. The USB driver for the cutting cutter must be entered in this list
otherwise no activation is possible.
If the USB driver does not appear there, install it from the delivered data
carrier of your device.

d. Original cable: Check if you use the original cable recommended by the
manufacturer. If this is not the case, there might be bigger problems during
the data transfer. CoCut „communicates” during the data transfer with the
cutter so that missing or faulty connected data cable with the cutter lead to
input or output errors.

Tip 7

7.8 Buffer Overflow

The cutter reports „buffer overflow” or does not cut the whole job

This is often because of an incorrect setting of the used protocol of the serial
(COM) port. In most cases it is sufficient to set the protocol respective the
flow control of the port to hardware.

Tip 8

7.9 Data Import From Apple Computers

Data import from Apple computers in CoCut

When exporting Apple data you have to pay attention to some settings to
have a perfect data export. All popular Apple compatible illustration and
graphic applications can export EPS data. (Illustrator, Freehand, …)

Tip 9

7.7 Cutter Does Not Respond!
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For the contours, as line width only hairline (0.01 mm) must be
entered.

1. 

No fillings should be transferred.2. 
All texts must be converted to graphical objects. (text in curves)3. 
Grouped or combined objects must not be available. (break up
before)

4. 

Especially with the Freehand-export the export filter for the
Illustrator-format must be selected.

5. 

As file name extension .eps should be used and you should not
use umlauts as ü, ä, ü.

6. 

7.10 Typical Sources of Errors When Cutting

a) The foil is clamped too loose

Consequence: the knive moves the foil during the cutting and the contour is
not closed completely.

Remedy: when inserting the foil pay attention that the foil is clamped evenly
and does not undulate.

b) The speed is too high

Consequence: small foil parts especially serifs and counters are
unscrewed.

Remedy: reduce speed and lower the pressure.

c) The tool pressure is too high

Consequence: the release paper is also carved, character parts are
unscrewed and parts of the release material get stuck at the characters. The
weeding of the foil gets more difficult.

Remedy: reduce pressure and correct the depth of the knife if necessary.

d) The tool pressure is too low

Consequence: foil and adhesive were only partly cut through. The weeding
is possible only with difficulty or not at all.

Remedy: increase the pressure and correct the depth of the knife if
necessary.

e) The knife is set too deep

Consequence: foil, adhesive and release material were cut. Foil cannot be
used any more.

Remedy: correct the setting of the depth of your cutting knife.

Tip 10

7.9 Data Import From Apple Computers
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f) The knife is used up

Consequence: only the foil and not the adhesive is cut through.

Indication: when using standard foil the using up of the knife is little.
When using reflection or sandblast foil the using up is much higher.

Remedy: use new original knife.

g) The characters were unscrewed

Consequence: The weeding border is possible only with difficulty. The
unscrewed parts stick to the foil and cannot be detached any more.

Generally is presumed: the smaller the font size the thinner the foil must be;
the adhesive force of the gluten is higher.

Remedy: reduce the speed and if necessary the tool pressure until this
effect does not occur any more.

h) The release paper is also cut

Consequence: the release material sticks to the foil. The weeding is
possible only with difficulty or not at all.

Remedy: correct the setting of the depths of the cutting knife and also
reduce if necessary the tool pressure.

7.11 Plotter Via USB Is Not Working!

Error message: Cannot open interface!

Check first, if your cutter is listed in the Device Manager (Control Panel /
System / Device Manager). If not, reinstall the device driver as described in
the plotter manual.

Check then, if the USB port for your cutter is selected in the CoCut Device
Settings. You'll find the Device Settings window in the Settings / Common
Settings / Devices menu.

Note: A USB cable should be no longer than 5 m without booster.

Tip 11

7.12 Summa Plotter Does Not Read Out!

Error message: Waiting for response... Cannot open interface...

Check, if your plotter is set on the device language DMPL. If the cutter is set
to HPGL, read out via cable is not possible.

Tip 12

7.10 Typical Sources of Errors When Cutting
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7.13 The Values for Cutting Pressure And Speed Are Not
Saved

After changing the values it is often forgottten to confirm the values. Please
press the  button beside the Enter Material field and enable the Save
Material Data option.

Tip 13

7.14 Error Message While Output into File

Error message: "Error for CreateFile"

This error message is given out, if the access right Write for the program
folder of CoCut is not set.

Relief: Enable write rights for the program folder.

Tip 14

7.13 The Values for Cutting Pressure And Speed Are Not Saved
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Annex

A Driver List

New or updated drivers can be downloaded from
www.eurosystems.lu/driver/index.dml?sprache=eng.

Anagraph
ANA Express AE-101 ANA Express AE-101e ANA Express AE-120
ANA Express AE-120e ANA Express AE-60 ANA Express AE-60e
ANA Express AE-70 ANA Express AE-75e

Aristo
AG 50 Offline AG 50 Signline AG 600
AG 75 Signline AG 75 Signline ABS GL_TL

Artsign
Artsign

ASC365
ASC365

Atlas
Atlas

Automated Cutting
Systems

ACS Design Studio Eagle

Cogi
CA 1300 CA 730 CP 630
CT 1200 CT 630 E 1360
E 720 E 870

Cole
CL1100 CL1350 CL720
CL870

COPAM
CP-2500 CP-3050 CP-3500
CP-4050 CP-4500

Creation
PCUT CR1080 PCUT CR1200 PCUT CR630
PCUT CR900 PCUT CS1080 PCUT CS1200
PCUT CS630 PCUT CS900 PCUT CT1000
PCUT CT1200 PCUT CT1300 PCUT CT1600
PCUT CT630 PCUT CT635 PCUT CT900
PCUT CTN1080E PCUT CTN1200E PCUT CTN1500
PCUT CTN630 PCUT CTN630E PCUT CTN900
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PCUT CTN900E

Creation HK
King Cut KCUT A1200 King Cut KCUT A24 King Cut KCUT A36
King Cut KCUT A48 King Cut KCUT A900 King Cut KCUT B24
King Cut KCUT B48 King Cut KCUT B900 King Cut KCUT CT1200
King Cut KCUT CT24 King Cut KCUT CT36 King Cut KCUT CT48
King Cut KCUT CT630 King Cut KCUT CT760 King Cut KCUT CT900

Desay
XP-300P XP-380P XP-450P
XP-540P XP-660P

DGI
Omega OM-100 Omega OM-130 Omega OM-150
Omega OM-40 Omega OM-60 Omega OM-70
Omega OM-80

Encad
NovaCut Series

Foison
C12 C24 C48
CT-1200 CT-630 FS-24
FS-48 S24

GCC
AR 24 Expert 24 Expert 24 LX
Expert 52 Expert 52 LX Expert II 24
Expert II 24 LX Expert II 52 Expert II 52 LX
Expert Pro-132S Expert Pro-60 i-Craft

Gerber
Sprint/4B old Sprint/4B Fastboard Sprint/4B new

Grafityp
CSR CSR Ecom 92 CSRTurboDMPL

Graphtec
Craft ROBO Craft ROBO PRO II

Helo
HSP 1360 HSP 360 HSP 720

Hengxing
Rabbit HX-1000 Rabbit HX-1120 Rabbit HX-1360
Rabbit HX-630 Rabbit HX-720 Rabbit HX-800
Rabbit HX-960

A Driver List

126



HobbyCut
ABH-1351 ABH-361 ABH-721

Jiachen
JC-1100DS JC-1100E JC-1100H
JC-1350DS JC-1350E JC-1350H
JC-720DS JC-720E JC-850DS
JC-850E JC-850H

Kimoto
Freecut 130 Freecut 150 Freecut 60
Freecut 75

LG Palopoli
MLP-24

Liyu
HC 1201 HC 751 HC 901
MC 631 MC 801 SC 1261
SC 631 SC 801

Master
XP-300P XP-380P XP-450P
XP-540P XP-660P

Masterplot
Masterplot

MAX
CM-200

New Star
Omega OM-100 Omega OM-130 Omega OM-150
Omega OM-40 Omega OM-60 Omega OM-70
Omega OM-80

ORXYZ
Elite HX-Series JML-Series
LX-Series OR-Series

Redsail
RS1120C RS1360C RS720C
RS800C

Refine
EH-1101 EH-1351 EH-721
EH-871 MH-1101 MH-1351
MH-721 MH-871
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Roland
PNC 1000 PNC 1100 PNC 1200
PNC 1210 PNC 1410 PNC 1800
PNC 1850 PNC 1860 PNC 2100
PNC 2300 PNC 2700 PNC 5000
PNC 900 PNC 910 PNC 950
PNC 960

Secabo
C120 C40 C60
C60 II S120 S160
S60

Seiki Tech
SK-1100H SK-1100T SK-1350H
SK-1350T SK-720H SK-720T
SK-850H SK-850T SK-870T

Silhouette
Cameo

USCutter
MH-1101 MH-1351 MH-721

Vinyl Express
Bobcat Lynx Panther I 24
Panther I 30 Panther I 40 Panther I 50
Panther II 24 Panther II 30 Panther II 40
Panther II 50 Panther III 24 Panther III 30
Panther III 40 Panther III 50 Puma I
Puma II R Series 19 R Series 24
R Series 31 R Series 39 R Series 44
R Series 53 ULTRA 24 ULTRA 30
ULTRA 40 ULTRA 50

VyTek
GEM40 GEM54

A Driver List
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B Dictionary of Technical Terms

Active and Passive Jobs Active jobs are those that are being cut. Passive jobs are
waiting in the queue for output.

Additional Programs Additional programs are program modules or stand-alone
programs that are part of the delivery.

Auto Import Plug-Ins Auto import plug-ins are used to automatically import
data from other programs - without intermediate steps.

Automatic Contour Pen
Conversion

This feature means that before the data is transferred the
software 'looks' for objects with the attribute 'contour'. If
so, the user can decide whether the contour is to be
converted or not. If the contour should be converted, then
a vector object with the width of the contour is
automatically generated!

Bitmap Functions Bitmaps are pixel images or photos. Bitmap
functions means all functions which are not vector tools
like node editing, and which are only applicable on
bitmaps.

By Color This is a welding function, which deletes all
surfaces, which are covered by overlying colors.

Bypass Cutting Direct cutting - without window - before output on the
cutter

CMX Data Transfer CMX data transfer means the handing over of data using
CorelDRAW's CMX data format. CorelDRAW had
created this format in order to ensure the exchange of
data within the Corel program families. CMX is a public
data format and is used for the exchange of data. This
has the advantage compared to EPS, that Corel specific
types of data can be copied 1:1, without making a
conversion of the format.

Cap Height Setting Cap height is the typographical correct unit of capital
letters. The text editor uses this unit by default when
calculating the font size.

Circular Text Is a special feature of the text editor with that text
blocks can be placed on or in a circle.

Clipart Tab Cliparts are job-similar files - often logos or patterns -
which are useful for the design of an output job. The
clipart tab is a sub-tab of the Sidebar, with that the
cliparts can be managed.

B Dictionary of Technical Terms
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Clone This function is usually used when creating labels and
series. Changes at the control object are transferred to
all clone objects.

Close
Objects (Automatically)

When importing DXF or HPGL data, many or all objects
are not closed. On a cutter only closed objects can be
processed reasonable. This function will automatically
close all vector objects. In the basic settings the
threshold for the closing of objects can be changed.

Contour Line (Print & Cut) Unlike the outline / inline bitmaps are here provided with
a vector contour. This function is regularly needed in the
creation of labels and stickers.

Create / Edit Text Block Text blocks are blocks of text that can be used more
frequently because they appear identical or similar in
many jobs - such as your address. With the PhraseWriter
arbitrary blocks of text can be created and modified as
needed.

Cut Out Region Is a bitmap function which provides the tracing of parts of
a bitmap. You can cut out any vector form out of a
bitmap.

Device Control This section deals with device control functions on the
output side.

Digitize Mode This feature means a drawing tool, that  similar
to digitizing tablet with a magnifier, draws nodes on the
working sheet.

Dongle Protection A dongle is a hardware copy protection that is stuck on
the USB port of the computer to make run the software.
The dongle protects producers against unauthorized
copying of its software and at the same time it protects
the investment of the buyer, since its competitors do not
get the software free of charge. Thus from dongle
protection both sides benefit - producers and buyers.

Drill Holes Drill holes is a special drawing tool, that marks the
position of a drill hole, using a crosshair cursor. If the
connected machine is capable of producing drill holes,
then the position is transmitted to the device driver.
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Files Tab Is a sub-element of the Sidebar, with that Jobs can be
managed. Job is the file extension, which is used from
EuroCUT.

Flatbed Cutter All cutters that have a flatbed as a cutting surface.

Folder Monitoring This function means that the software monitors a
selected folder on hard disk or network. Every time when
a change in the monitored folder occurs - by saving or
deleting of jobs -  the thumbnail gets updated.

Fontmanager The Fontmanager manages fonts in databases. The
advantage of this method is that the database can be
copied from one computer to another and thus the same
set of fonts is available on both computers.

Full Surface Is a welding function, which underfills objects in one
color, whose surfaces overlap another. The partially
hidden objects are treated in a way, that they are
underlaying all overlying objects.

Hatching In this milling method the area, which should be
removed, is provided with a hatching. The area gets
removed along the hatching using the milling tool.

Hotfolder Management A folder can be defined as a so-called hot folder. All
output jobs that are stored in this directory are supplied
to the output.

Job Calculation The Job Calculation means a function with that
preliminary costing can be done easily. This function is
particularly well suited for calculating charges of material
costs.

Job Info The Job Info can - referring to each job - save additional
information such as order number, customer address,
material, time spent, a. s. o..

Job Rerun Any job that is still in the job history can be cut again
identically. The actual to the machine transmitted data is
stored. All parameters are given out into the output file.

Laser Engraver Name for all devices which don't use an engraving
needle but a laser unit.

 - This device type is supported by the software suite
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OptiScout. Full info at: www.optiscout.com

Layer Tab Is a sub-element of the Sidebar, with that layers can be
managed. Layers are color levels which determine and
control output order and tool parameters - besides object
position.

Material Display Each color layer can be assigned a specific material with
an exact material description. The assigned material is
displayed before the output in the Job Calculation, Job
Info and the layer itself.

Milling & Engraving This rubric lists the specific functions and tools which
were implemented for milling and engraving.

Monitor Output Process With monitoring, we mean that the output process can be
suspended, stopped and continued. Active jobs can be
switched to passive and if necessary be re-activated.

Multi Inline In this milling method the area, which should be
removed, is provided with multiple Inlines. The area gets
removed along the inlines - from outside to inside.

Multi Port Support With this we mean that all ports on a given computer -
which are suitable for the issue - can be used. Typically,
these are all COM and USB ports.

Multi User Versions
Available

For every main license multi-user version can be
purchased. The additional versions here have the same
serial number as the main license.

Multi-functional Cutter Multi-functional cutters are devices which can use
various tool heads beside a cutting tool head. They are,
for example, oscillating knives, spindles, and hemming
tools.

 - This device type is supported by the software suite
OptiScout. Full info at: www.optiscout.com

Multiple Cutting Option to cut easier thick and resistant materials

Node Editing Main tool for the creation and editing of vector objects.

Objects Tab Is an sub-element of the Sidebar with that objects can be
managed. A large number of object attributes such as
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visible / invisible, do not output, do not print, can be
individually defined for each object.

Open Trimming Is a welding function, which creates open vector objects,
after they were separated at their intersections.

Optimization Targets of the optimization are: diminishing of rejection
rate, material saving, time saving, optimization and
shortening of job preparation. The optimizing of objects
can be done on the working sheet or in the output
preview. The objects are sorted so that the material
consumption, without nesting of objects, is minimized.

Outline / Inline Outline is a special function, where vector object is
contoured automatically with a contour in a predefined
distance. In contrast to the contour line, the outline
creates - in case of internal objects - so called Inlines.

Parallel Device Output This function can simultaneously provide data on multiple
machines, which are connected to a computer, if
sufficient computing power on the PC is given.

PhotoCUT PhotoCUT is a program module which can convert
halftone drafts into vector stripes. The so generated
vector stripes can be cutted on each usual cutting plotter
and, generate - with the appropriate viewing distance -
one photo-like effect.

PhraseWriter The PhraseWriter is a program module for the
management and use of text blocks. It is automatically
started at startup and is accessible at any time using the
right mouse button context menu. The specified text
block is selected and then inserted and displayed on the
desktop.

Plot Manager The Plot Manager is a separate program module, which
'background' controls and monitors the output of the data
on the selected device.

Plot Server Function
(TCP/IP)

A computer at which multiple output devices are
connected can act as a plot server. The data transfer can
take place via the network using TCP / IP. Assuming the
appropriate licenses, any number of client computers can
give out on the plot server devices.

Plot to File The output of the plot data can be redirected to a file.
The user only has to activate the appropriate option in
the output dialog.
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Posterize Posterize is a bitmap function which performs a reduction
on any number of color hues per color layer.

Preview *.CDR and *.CMX The files tab can display besides *.JOB also contents of
*.CDR and *.CMX files (CorelDRAW formats).

Productivity Tools Productivity tools are special tools, which - because of
their workings - enhance the productivity of sign making
processes. These are usually such tools, which
distinguish a cutting software from illustration programs
such as Illustrator and CorelDRAW.

Program Type This section summarizes certain criteria which
characterize the use of the program.

Reference Job (*.JRF) In a so-called Reference Job the environment, the tool
parameters and the device drivers are stored. In this
way, it is possible to output the job in an identical manner
as many times as wished.

Register Mark Is a special drawing tool, with that marks, for the making
of multi-colored foil signages, are drawn. This register
marks can consist of a cut-through or a filled square and
are positioned by the user to the desired position on the
output job. While the output these registration marks are
always cutted at the same position on the vinyl
(layer independently), so then the precise assembly of
various colors is possible.

Roll Cutter Roll cutter means all cutting plotters, which can only
handle material rolls.

Screen Printing Is a welding function, which allows the changing of the
color stack. Thus, the order of the colored vinyls can be
re-sorted - interactively - from light to dark.

Segmentation with Overlap Segmentation is always necessary when the job is larger
i.e. longer or wider than the connected device is able to
plot. The overlap is necessary when the individual
segments are to be completed to a whole again. Joining
otherwise would lead to undesired white gaps.

Sidebar Sidebar means a movable control element that can be
made visible on the desktop. The individual sub-elements
are activated by clicking so-called 'tabs'.

Sort with Simulation In this function, all objects are sorted according to a
certain criterion. For some output devices such as lasers
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or milling machines the sequential processing of the
objects is important. Therefore, the output can be
simulated and the collation can be adapted to the
requirements of the output device.

Space (1/1, 1/2, 1/4, 1/8) Special function with that micro-typographical-correct
spaces (keyword: em quad) and thus word / letter
spacing can be generated. These special spaces can be
directly entered via the keyboard.

Spool Function When the Plot Manager is activated with the parameter
!SPOOL!, it runs independently without starting the main
program. Output data can be activated and given out via
Drag & Drop.

Spot Colors Definable Spot colors are color layers, which are defined in a way
that color values are additionally given out. Some hybrid
devices and RIPs use spot color values for the control of
output processes. When printing the corresponding color
plates are given out.

Stacking Stacking means that at first as many objects are
positioned adjacent as will fit on the material. The
following objects are then positioned above it. This
process is repeated until all objects are positioned on the
material.

Stand-alone Software "Stand-alone" means that this program can be used
without any other so-called host program. It has all the
tools that are needed for the design, layout, and the
output of jobs.

Start Tool Paths When milling and laser engraving it often happens that
immersion traces are visible at the start point of an
object. To ensure that the quality of the objects which are
milled is not affected, the start point can be laid outside
the object. This task is performed by so-called start tool
paths.

Status Display Material
Consumption

In the output preview at the bottom of the window is a
status line where the material consumption of the job is
displayed in square meters. Since this happens before
the output, this feature can also be used to order exactly
as much of a material as is required currently for the job.

Symmetrical Object This is a tool that can create stars and polygons. With it
the initial shape (circle, ellipse) and the number of edges
can be specified. With its own drawing tool then the
symmetric objects on the desktop are drawn.
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Templates (*.JTP) Templates or patterns are jobs which have no
name (untitled) when opened. Templates can always be
created if they can serve as an example for other similar
jobs. The advantage is that the working sheet and layout
are predefined.

Test Run Before the actual output a so-called test drive can be
carried out to examine whether, for example, the material
is sufficient. During the test run the raised tool head
moves along the vectors.

Text Editor Text editor means program functions that include all the
tools necessary for professional capturing and editing
texts. Typographic special tools that are essential for
signmaking were implemented.

Text Import (*.TXT, *.RTF,
*.ECT)

External texts can be imported directly into the so-called
text box, with the above formats being used. For
formatted text the RTF format must be used. It can be
saved from every professional word processing program.

Thumbnail Preview Thumbnails are small low-resolution pixel previews of file
contents. All in the selected folder located files will be -
by means of the thumbnail preview - visible and
manageable.

Tool Parametrization Means that specific settings for a tool can be done by the
user. This can be values for speed, drive, depth, angle,
pressure, acceleration or other parameters. The device
driver provides the parameter fields. The user can edit
corresponding parameter values before the output on the
device.

Tool Assignment To each color layer a specific tool can be assigned. This
makes creation and processing of jobs much easier. The
selected device driver provides all possible tools. The
assignment itself can be done by the user individually.

Track Logging For each tool the distance will be recorded. In addition,
the date, time and device names are stored.

Trimming Is a welding function, which separates closed vector
objects using lines or curves. The resulting partial objects
are re-closed then automatically.

TrueType, OpenType, Type
1, BE Fonts

These 4 font formats can be managed with the
Fontmanager i. e. add, enable and disable.
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URW BE Fonts The BE-type format was created by the company URW.
The BE-format is a vector font format that was shipped
with SIGNUS systems.

Vectorization, Tracing Vectorization means the conversion of bitmaps (pixel
images) to vector contours.

Video Marks (Print & Cut) Video marks are marks that can be detected by cutters
with optical sensors or cameras to compensate for
inaccuracies of the print result. In the print and cut
process they are used also for the contouring of print
objects.

Wait After Segment If a job has to be segmented, then the user receives this
option with the ability to re-equip the machine before the
next segment is processed. By means of a message
window the process can be continued at any time.

Weed-Ex Driver Option It is a specially laminated flex or flock material of Witpac
GmbH. First, the actual vector lines are cut. In the
second step, the components that need to be weeded,
are cut out in a way, that they 'fall out' automatically at
the end. So you have already reached the entire plot
result after peeling off the medium and you don't have
to weed manually.

Weeding Lines horiz. / vert. In addition to the global weeding frame, which is
generated around the entire output job, individual
weeding lines can be added horizontally or vertically in
the output preview. Large, bulky jobs can thus be
divided.

Welding Welding functions are needed for the treatment of
overlapping of layers or vinyls. These functions are in the
signmaking and screen printing department essential for
the processing of vinyls.
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C Glossary

Additive color system The ~ is based on mixing the additive, luminous spectral colors
red, green and blue (RGB), for example in color TVs or color
monitors

Adjustment Modification of the distance between two adjacent characters
so that a harmonic type face is being created. This is reached
by correcting the character - or word distance.  With distances
below 100% you speak of kerning and with values above 100%
of spacing out.

Adjustment handles ~ are the 9 black squares that are drawn around the object and
in the middle when marking objects.

Antialiasing Edge smoothing with bitmaps

Application tape Foil that is used to apply the cut foil after the weeding on the
lettering area. The adhesive force must be strong enough so
that the text - even the tiniest letters - can be released from the
substrate without problems. After application, the ~ must also
be released without problems. 

Ascender Term for the part of a character that extends above the middle
length.

Backup Data backup

Bit-depth also shade ~ is the mathematically possible number of colors with a
specific number of bits, for example:
1 bit color depth = 21 = 2 possible colors (black/white)
8 bit color depth = 28 = 256 possible colors/shades of gray
24 bit color depth = 224 = 16.8 millions possible colors

Bitmap Pixel-graphic

Bold Font that a bit thicker than the standard typeface.

Byte Smallest addressable unit in the computer memory, consisting
of 8 bits.

Calibration Adaptation of printer, monitor, cutter or adaptation to desired
values.

Cap height This is the height of the capital letters, the capitals. As
measurement usually the height of the letter „H” from the font
line to the top edge of the character is used.

Center justification A break justification where the text block is justified at the same
time on the left and on the right side. To do this, the word
space within a text line is varied (usually extended) so that on
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the left and right side a clean text edge is created. This is not
only applied for the the last line of a break.
compare also: forced block

Clipart(s) ~ are jobs or job parts that were added to the Clipart toolbar .
They are saved in a separate directory. (C:\Program
Files\EUROSYSTEMS\CoCut Starter 2017\CLIP)

Clipboard ~ is used for temporary storage in Windows.
The ~ is used to exchange data fast between applications. 

CMYK Cyan, magenta, yellow, contrast (key, black) Standard colors
for the four-color printing.

CMYK-color area ~ is the total number of colors that can be displayed by the
colors used when printing (CMYK).

Color depth ~ is the number of possible color tones that can be recognized
by a scanner or reproduced on a color monitor.

Container A container - more exactly an image or text container - is a
vector object, that similar to a real container can take up
arbitrary image data or texts. In conjunction with macro scripts
contents can be exchanged semi-automatically or
automatically.

Context menu Context menus are called so because the structure adapts and
changes depending on the number and type of the selected
objects (context). Context menus are always activated with the
right mouse button. They serve for the faster access to
important functions and tools and also to those functions that
cannot be activated via the main menu.

Contrast Contrast; range of brightness between bright and dark parts of
a picture.

Cursor ~ is the blinking, vertical line in an editable field.

Decoration Accentuation of text parts by modification of the text attributes,
for example bold, italic.

Descender This is the part of a character that protrudes below the font line.

Desktop The area besides the working surface that can be used for the
draft. It is comparable to a desk on which are the tools.

Digitalization Conversion of a picture template into a digital form. The
capture is done point for point or line by line by means of a
digitalization tablet or by reading the template with a scanner.

Dongle
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Means the copyright that is part of the scope of delivery of
CoCut. It is inserted in the USB interface of your computer.
Without ~ the software cannot be started.

Download Downloading applications or files from the internet to your
computer.

DPI Acronym for Dots Per Inch; resolution fineness (1 inch = 2.54
cm)

EPS Acronym for „Encapsulated Postscript Format”. In this file
format the text and picture information is saved in the page
description language postscript. This format also contains
besides text and raster data also a preview bitmap which
allows displaying a copy of the data on the screen.

Foil Two production processes are common: calendaring and
casting. Cast foil is created without drawing frame and thus has
a lesser shrinking tendency. The costs are usually higher than
with calendared foil. Calendared is cheaper, has a shorter
period of usage and shrinks more.
Cutting foils are built in three layers:
1. Substrate; the lowest layer
2. Gluten layer; is between the foil and the substrate
3. the foil itself.

Font Type cut within a type face in digital form. Most type faces
have the fonts normal, bold, italic and bold-italic. Often, the font
is used for the same type face. Correct would be that each cut
is a separate font.

Font line ~ is a thought line on which the characters of a row are
standing. Even if different font types and font sizes are used
in a row, all characters must stand on a common font line.

Font size ~ is the size of a font. It corresponds to the block height, which
means it also comprises the ascender and descender as well
as a certain space above and below the characters. 

Forced justification Justification where all text lines - also the last- are adapted to
the width of the column or the working area. In CoCut this
justification is called „force justification”.

Gamma correction The ~ is a method for the correction of color graduation
considering the perception of the human eye if there are two
adjoining areas of different color.

Group Combination of arbitrarily many objects to a group. The
position of the objects itself does not change any more within
the group.
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Halftone image(s)  ~ are pictures which contain shades of gray or hues. The tonal
value between pure white and pure black is called halftone.

Hotfolder A Hotfolder is a directory monitored by the Plot-Manager. If a
file is copied into this directory, the Plot-Manager carries out
automatically specific configurable functions.

Inch Measurement unit for the length
1 Inch = 2.54 cm

Job File-ending of CoCut; name for CoCut file

Justification Alignment of a text block on the working area. CoCut offers
justification left-aligned, right-aligned, centered, center
justification, forced center justification and adjust cap height.

Kerning If two characters stand closer together than it would
correspond to their standard thickness, you speak of ~. With
character combinations as for example „Te” you have a
balanced type face.

Laminating Covering with transparent plastic films.

Live-Update Updating of software via the internet.

Macro A ~ automates program flows. The automation can thereby be
realized with the program's own commands or a macro
language.

Marking function ~ means marking objects by keeping pressed the left mouse
button, then drawing a frame around the objects to be marked
and letting go the mouse button only if all objects to be marked
are completely within the frame. 

Process colors Printing scale of colors for four-color-printing with cyan, yellow,
magenta and black (key). By mixing these colors, it is possible
to print all colors.

Profile The appearance of program surfaces is called ~. The shown
tools and menu items can be individually adjusted to the
user. Intention is to simplify the user interface.

Raster Image Processor short: RIP - Software that rasterizes vector data and controls
the printing on a large format printer.

Resolution Number of pixels per track unit. It is indicated in dpi (dots per
inch). Laser printers have a resolution from 600 to 1200 dpi.

Scan resolution Fineness of the resolution when scanning analogue images
Formula:
Resolution (in DPI) = printing length (L/cm) x 2 (quality factor) x
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enlargement factor x 2.54 (when converting from cm into inch)

Subsidiary line These are lines for the virtual alignment of objects on the
working area or the desktop. Subsidiary lines are only visible
on the monitor are neither plotted nor output on the printer.

Superscript The characters are set higher than the characters standing on
the baseline. They usually have a bit smaller font size than the
basic font.

Toolbar can be freely moved and positioned on the working area of an
application. Often, also the composition of the tools can be
defined.

Trapping A small overlapping zone at the limit of superposed colored
elements. This ~ guaranteed that no white gaps occur at the
color borders. The overlapping can happen through overfilling
or underfilling.

Upload Upload is the sending of files or applications to a networked
server

Weeding means the removal of unnecessary foil parts after the cutting
with a cutting plotter. 

White gaps ~ are the gaps on the edges of overlapping or abutting color or
foil areas. Disadvantageous especially with silk-screens or
when printing.

x-height Height of the lower case/character „x” respective the lower
case without the ascender of a font.
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CMYK  139

Color graduation  36, 140

Color palette  67

Combine  56, 68, 98

Contour line  98, 130, 133

Contour pen  129

Contrast  133, 139

CorelDRAW  7, 129, 134

CoRUN  22, 85, 95

D

Device driver  23, 35, 36, 66, 123, 130, 136

Device Options  114

Device Options  114

Digitize mode  130

Drag & Drop  135
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E
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File formats  52, 66, 90

Files tab  131

Foil optimization  45, 46, 50, 91, 92, 98

Font size  123, 129, 140, 142

Fontmanager  131, 136

Forward one  59

Freehand  7, 21, 121, 122

Full surface  131

G

Gamma correction  140

GIF  29

Grouping  45, 56, 59

GTP  29, 73

H

Hairline  122

Hatching  131

Horizontal mirror  55, 91, 98

Hot folder  131

HPGL  29, 73, 123, 130
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IK  29

Illustrator  7, 21, 121, 122, 134
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Import filter  31, 66, 70, 71, 72, 73, 74

Inline  130, 132, 133

Invisible  81, 88, 133

J

Job info  51, 97, 131

Justification  138, 140, 141

K

Keep reference point  64

Kerning  138, 141

L

Laser  131, 135, 141

Local device  33, 36

M

Macro  68, 70, 139, 141

Macros  4, 68, 70

Magnifying glass  101, 102

Margins  27, 28

Material consumption  45, 133, 135

Maximum optimization  46
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N

New origin  41, 64

Node editing  56, 129, 132

Node editing tool  56

Number of outputs  114

O

Offset  40, 54, 61

Online support  4, 85, 95

Open Job  97

Open trimming  133

OpenType  136

Optimization  45, 46, 49, 50, 91, 92, 98, 133

Orientation  14, 27, 28, 61, 79

Outline  130, 133

Output preview  39, 42, 44, 47, 91, 92, 93, 96, 101, 133, 135, 137

Overlap  49, 65, 131, 134
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Passive Jobs  108, 109, 110, 111, 129

PCX  29

PDF  7, 29, 30, 73, 74

Pen thickness  36

PhotoCUT  133

PhraseWriter  130, 133
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Plot to file  40, 65, 109, 112, 115, 133

PLT  113

Positioning  56

Posterize  134

Print & Cut  130, 137

Producer  4, 7

Q

Queue  129

R

Read out  65, 123

Recalculate  92

Rectangle  39, 120

Redo  53, 62, 82, 97

Redo  53, 62, 82, 97

Reference Job  134

Reference Point  40, 64

Reference point  40, 64

Refresh screen  60, 89

Register mark  134

Register marks  43, 134

Registration marks  134

Relief  124

Reverse cutting  49

RGB  28, 138

Ruler  80, 81, 87, 88, 120
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Save as  51, 91, 110, 111, 112, 115

Scan  97, 141

Screen printing  49, 134, 137

Segment  39, 40, 49, 50, 64, 65, 137

Segment optimization  49

Segmentation  40, 48, 49, 50, 134

Separate  48, 68, 133, 139, 140

Shades of gray  141

Smooth  8, 13

Spooler  35, 113

Stack  39, 43, 59, 64, 65, 134

Stack distance  65

Stack processing  64

Stack spacing  65

Start tool paths  98, 135

Step by Step  120

Subsidiary lines  82, 142

Superscript  142

Symmetric objects  135

T

Template  49, 68, 139

Test drive  42, 92, 136

Text editor  129, 136

Text in curves  122
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Thumbnail  131, 136

Thumbnails  136

TIF  29

To back  59

To front  58

Tool assignment  39, 65

Tool parameters  134

TrueType  136

Type 1  136

Typeface  138

U

Undo  53, 62, 82, 97

V

Vectorization  137

Vectorization  137

Vertical mirror  91, 98

Video marks  39, 69, 137

W

Wait after segment  64

Weed border distance  39, 45

Weeding frame  42, 46, 47, 65, 92, 96, 137

Weeding lines  46, 47, 48, 92, 137

Welding  129, 131, 133, 134, 136, 137
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